OnCommand® Insight 7.2

Performance Guide for the Java Ul

March 2016 | 215-10383_A0
doccomments@netapp.com

i NetApp-






Table of Contents | 3

Contents

OnCommand Insight Performancefeatures ...........cccoocevereninencneeeenne, 6
Setting and managing switch thresholds and performancealerts........... 7
Adjusting SWiItch threSholds ..o 7
Switch threshold types and formulas ..o 8

Changing or disabling switch thresholds ..o 9
Managing performance @lerts ... 9
Reviewing and confirming alerts ..........ccccoeoreieneinenneneee e 10

Examining network performance ..........cccoeeoevevecce e 11
Searching for performance data ..o 11
Performance trend analySiS .......oooeiereieieeeee s 13
Identifying reasons for performance Changes ... 14
Monitoring system changes that impact performance ...........ccoccooeveninieienciciiees 15
Monitoring Fibre Channel switch performance ...........ccccoveriiinninsineineicneens 16
Monitoring data Store PerforManCe ............ccocveiiriieninene e 17
Monitoring storage Performance ..o 18
Customizing global general pOlICIES ........ccooiriiiiiiiiiiinee e 20

General policy types and their hierarchies ... 21

Identifying performance treNdS ..........ccooe e s 22
Exporting performance data as an image or file ..., 23
Grouping data IN VIBWS ........coiiiriiriiriesienieie ettt sttt s 24
Monitoring virtual machine performance ..........ccoceoeeereneneneneneneens 25
Viewing virtual machine performance and utilization ...........c.ccocveniiiniiiiciiies 25
Setting virtual machine thresholds ..., 26
Determining where to add a data store to achieve load balancing ............c.cc.ccoceeee. 27
Selecting an active path for a virtual machine data store ..........ccocoecevevevieinivecnennn, 28
Adding a host to a virtual cluster to share a data Store .........ccocceeerererciciniecisenen 29
Determining if a VM is affecting host performance ............ccocooveineiieiienienen, 30
Troubleshooting performance problems ... 32
Troubleshooting slow client computers on your NEtWOrK ...........ccocevvveiieniennennas 32
Troubleshooting poor application performance ...........ccocooveneie e 33
Analyzing traffic flow and identifying congestion ............ccccceeevenencnnens 35
Identifying @ coNGESted NOSE .........ooviiiieec e 35
Analyzing congested SLOrage POILS .........civrererieirieeiieistereeie et nes 36
Analyzing virtual storage Performance ..........cocooeieeieenienesce e e 36
BalaNCiNg IES0UICES .....cueiuieiieieiesie et 38
Analyzing port balance VIOIations ... 38
Identifying out-of-balance network traffic across host ports ..........cc.cccceee.e. 39

Identifying resources for storage allocation ..o, 40
Analyzing storage port balance Violations ..., 40

Identifying an available Storage array ..........ccocooevininienienne e 41

Selecting StOrage POIS ......cvvveireerieire e 41



4| OnCommand Insight Performance Guide

Identifying volumes with potential capacity .........ccccovverrenieniceniienee 41
Identifying Tier 1 to Tier 2 data migration candidates ..........c.ccocerererreenns 42
Balancing data flow across storage array POItS .......coccoevevererenerenenesenesenese e 42
Balancing data fIow aCross ISLS .......ccoieiiriiiieieieee s 43
Allocating capacity t0 @ NEW NOSE ........ccoeiiiiiiiee e 43
Allocating capacity to an existing NOSt ..........cccooviiiiiiiin e 45
PerformanCe refereNCEe ........ooeeeeeeeee s 47
Automatic storage tiering in Inventory and Performance VIews ..........c.ccocoeeiereennee. 47
ANAIYZE AIAI0G DOX ...o.vovieiiiiiiee 47
Daily Performance Pattern histogram ..........c.ccoceoeiineienniisinieeecne e 49

Data Store SUMMAry tah ... 49

DISKS T8I0 ...t 50

HOSE SUMMANY taD ..o e 52
Internal Volume SUMmMAry tab ........coocoiiiiii e 54
Storage Pool SUMMArY tah ........ccooiiiiiic s 55
Virtual Maching SUMmary tab ... 56
Volume SUMMATY A0 ..o 57
Application Performance VIEW ..........cccoeciiiiiininene e 58
Backend Volume Performance VIBW ..........ccocevveveieieniese e e 61
Datastore PerformanCe VIEW ...........cccoioiiriieniieneenei e 64
DiSK PerfOrManCe VIEW ........cccvvvieiireieiesee ettt st ns 67
HISTOGIaM VIBW ...ttt st 69
HOSt PEIrfOrMAaNCE VIEW ......oiveieicieie et 70
Internal Volume Performance VIBW ..........ccccoeriireinieinieine s 74
Internal Volume Usage of Storage POOI VIEW .........ccoceiviiiiiiiiinci s 77
Performance Chart ..o 77
Performance DiStribDUtiON VIEW .........cccoviiririeienceie e 79
Port Performance DiStribUtioN VIEW ...........ccciiiiiiriiniiniceieseseseees 80
Settings for Host Virtualization poliCies ..o 80
Settings for VM Hosts Thresholds ... 81
Storage PErfOrManCe VIEW .........cociviiriiiiiiiiisien s 82
Storage PoOl Performance VIBW ...........ccocoiiiiiiniiieie e e 85
Storage Resource Performance Chart ... 89
SWitch Port PErfOrmance VIEW ...........cooiriiiiiineineincisiese s 90
SWitCh Threshold SELHNGS .......ccooveiriiiieire s 92
Switch threshold types and formulas ..., 93
TOPOIOGY VIBW ...ttt et 94
VMDK PerfOrmance VIEW ..........ccceriiiriiiniiinieinieineesiese e 95
VM DIStIIBULION VIBW ... 97
Virtual Internal Volume Performance VIEW ...........ccooevieniiniienseneenee e 98
Virtual Maching Performance VIEW ..........cccovviviviininniesene e e 101
Virtual VoIUME USAQE VIBW ......ocuiiuiieiriiieiieiieie ettt e 103
VOIUME PErfOrMAanCE VIBW .....c.cocveieieicieese st 104
Volume Usage of Storage POOI VIBW ........ccoieiiiiiiiiiiiice e 107

Copyright iNfOrMation .........c.coieerieie e e s 110



Table of Contents | 5

Trademark inforMation .........ccooeeeieeie e e 111
How to send comments about documentation and receive update
NOLITICALTIONS ...t esne e 112



OnCommand Insight Performance features

OnCommand Insight extracts near real-time performance information from your storage environment
and maps it to applications, hosts, and access paths. You can search for objects with problematic
performance and analyze the related data. These features allow you to use your resources efficiently
and help you solve performance problems quickly.

OnCommand Insight Performance includes the following features:

« Heterogeneous Fibre Channel switch fabric performance data for hosts and storage ports
« Automatic discovery, collection, and maintenance of performance metrics

» Search facility linked to performance analysis

« Data about volume congestion and excessive utilization

» Service level performance monitoring

OnCommand Insight provides visibility into the actual storage capacity consumption on every FC
port in the monitored environment (host, switch, or storage). You can also obtain statistics on volume,
internal volume, and disk performance.

Armed with this information, you can identify expensive tier 1 arrays that have applications that can
be moved to tier 2 based on low traffic. After the migration, you can validate that you have not
negatively impacted the performance of the applications while balancing your storage usage.

Related concepts

Analyzing traffic flow and identifying congestion on page 35

Related tasks

Searching for performance dataon page 11
Troubleshooting slow client computers on your network on page 32
Troubleshooting poor application performance on page 33



Setting and managing switch thresholds and
performance alerts

The administrator can set thresholds that trigger performance alerts and violations.

OnCommand Insight monitors the activity on each switch port. You can change the default thresholds
that constitute policies. If these policies are violated, an alert is issued.

Adjusting switch thresholds

You can adjust the default switch thresholds to establish your performance policies. If these
thresholds are exceeded, OnCommand Insight generates performance alerts.

Steps

1. From the OnCommand Insight Open menu, select Assurance > Switch Port Performance
Alerts.

2. Right-click on a threshold and select Configure.

3. In the Settings window, set the minimum and maximum switch thresholds and the period in

minutes.

£ Switch Thresholds

Set switch performance thresholds based on what the switch is connected to.

&+ Host | 4 Switch | .sStorage | 2J Generic Device | .22 Tape |
Tx Utilization (%) Min: =
Period (minutes): [ Max;
Rx Utilization (%) Min:
Period (minutes): Max:
Utilization (%) Min:
Period (minutes): [ Max:
CRC (%)
Period (minutes): Max: 60 E

Other Errors (%)
CIMax: |

Period (minutes); |

Loss of Sync

OO ra: |

Period (minutes): | |

Loss of Signal

Period (minutes); | CImax: | 1|

Class 3 Discards

[#] Man:

Period (minutes);
Frame Size Too Long

Period (minutes): Mai: a0 E
Frame Size Too Short

Period (minutes): Max: &0 E

BB Credit Errors

[CIMax: |

Period (minutes): |
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Switch threshold types and formulas

OnCommand Insight uses these formulas to determine the switch port performance threshold data.

as a percentage of the total data traffic.

CRC frame errors indicate bit errors
somewhere in the data path and point to poor
connections, bad cables, or links that are too
long.

Threshold Description Formula

BB Credit Fibre Channel uses buffer-to-buffer credits to

Errors control transmission flow. The credit value is
decremented when a frame is sent and
replenished when a response is received. As the
available credits for a given port approach zero,
the error warns that the port will stop receiving
transmissions when zero is reached and will not
resume until the BB credits can be replenished.

Class 3 The count of Fibre Channel Class 3 data

Discards transport discards.

CRC Rate CRC Rate is the measure of CRC frame errors

AcreErrors 100
ARxFrames

crcErrorRate =

Errors Rate

Total number of errors (Loss of Sync, Loss of
Signal, and Framing)

Aerror 100

errorRate(%) =
Aerror + ARxFrames + ATxFrames

Frame Size The count of Fibre Channel data transmission
Too Long frames that are too long.
Frame Size The count of Fibre Channel data transmission
Too Short frames that are too short.

Loss of Signal

If a Loss of Signal error occurs, there is no
electrical connection and a physical problem
exists.

AlossQfSignal 100

lossOfSignal / sec(®0) =
Asec

Loss of Sync

If a Loss of Sync error occurs, the hardware
cannot make sense of the traffic or lock onto it.

lossOfSvne | sec(%) = AloaS0/SyHE00

All of the equipment might not be using the Asec
same data rate or the optics or physical
connections might be of poor quality.
The port must re-sync after each such error,
which impacts system performance.
Received Percentage of available bandwidth used for Rx.
Utl I I Zati on RxUtilization(%) = — ORBis100
ASeconds ActualSpeedBits
Transmit Percentage of available bandwidth used for Tx.
Utilization TxUtiization(%%) ATBits 100

* ASeconds ActualSpeedBits
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Threshold Description Formula
Utilization Percentage of available bandwidth used for Tx
and Rx. max(ARxBirs, ATxBits) 100

Utilization(%) = —
ASeconds ActualSpeedBits

Changing or disabling switch thresholds

You can change switch thresholds at any time. The threshold set at a particular time appears when an
alert condition occurs. You can also disable thresholds.

Steps

1. From the OnCommand Insight Open menu, select Assurance > Switch Port Performance
Alerts.

2. Inthe Switch Port Performance Alerts view, right-click on a threshold and select Configure.
The Switch Thresholds settings dialog box opens.

3. Change the values as needed.

4. To disable any thresholds for which you no longer want to receive alerts, clear the Max and Min
check boxes.

5. Click Apply to save the changes on one tab and move to another tab.

6. Click OK to save all of the threshold changes.

Managing performance alerts

An alert is triggered when the performance metrics for any port exceed the threshold for the time
specified. You can review these alerts and identify the switch and port on which the alert condition

occurred.

Steps

1. From the OnCommand Insight Open menu, select Assurance > Switch Port Performance
Alerts,

2. Inthe Switch Port Performance Alerts view, select one or more entries in red.

3. Click the Alertsicon.

Select one or more entries in the Alerts list.
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5. To determine the cause of the alerts, click the icons for any of these views:
» Switch Port Performance to evaluate traffic distribution and port utilization.
» Performance Chart to identify any issues in performance trends over a specific duration.

« Changesto identify any system issues that might have initiated this alert.

Reviewing and confirming alerts

After you identify the cause of an alert or determine that you no longer need to be reminded about
that alert, you need to clear alerts from the Switch Port Performance Alerts main view and Alerts
detail view.

About this task
An alert is triggered when the performance metrics for any port exceed the threshold for the time

specified.

Steps

In the OnCommand Insight Open menu, select Assurance > Switch Port Performance Alerts.
Expand the alert categories and select an alert that you want to examine in more detail.

Click the Alertsicon to see all of the switches and ports associated with the selected alert.
Select one or more of the switches in the Alerts view.

Click the Performance Chart icon to see a graphic display of the alerts.

© g A~ w DM B

You might also want to display the Changes and Switch Port Performance information for
selected alerts.

7. To confirm and delete an alert from the display, right-click the line in the Alerts view.

If you do not confirm an alert, it appears every time you display the Switch Port Performance
Alerts view.
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Examining network performance

You can examine your storage environment performance and identify under-utilized and over-utilized
resources and identify risks before they turn into problems.

Insight helps you to resolve or prevent performance and availability problems that are revealed
through the collected storage data.

You can use Insight to perform these performance management tasks:
« Monitor performance across your environment

 ldentify resources influencing the performance of other devices

Searching for performance data

You might use the Search facility to display performance data for a portion of your environment that
appears to be causing problems. For example, suppose an administrator in the energy business
receives a call from a field office reporting that the Sea Current Generation application is running
slowly on the server for an energy exchange in New York. You can enter the host name or portion of
the name into the Search box to display a summary of the performance information.

Steps

1. Inthe Search box at the top of the Client window, type at least three characters of the host name.

The search begins immediately. In this example, the administrator enters exchange to see a list
of all objects with “exchange" in the name.

|q exchanige o

Best Match § "exchange_nv1" {192.1,168.16)

Host @ ‘"exchange_nyl" (192.1.168.16)
“exchange_njl" (192.1,168.15)

The search results list a New York host (exchange_ny1) and a New Jersey host (exchange_nj1).

2. To examine the performance details for the New York host, double-click the New York host in the
search results.

The Host Summary tab of the Analyze dialog box opens to show the description of the host and
list problems with the storage resources.

3. Inthe Host Summary tab, check that the correct host name is listed in the description and note
what might be wrong.

In this example, the administrator confirms that the selected host is in the New York data center
and is running the Sea Current Generation application. In the list of eight Storage Resources, all
of the resources show response times in red indicating that they are higher than the performance
policy threshold.
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©

> f'—'@,Host exchange_ny1 12/6/12 12:009M -1

2/7/12 12:00 PM

Lstash ]2

Machines | VMDKs

I

Patterns

[ SAN Path Violations | Switch Ports

S
Host Summary Disks

Volumes

T

Intemal Volumes

Backend Volurmes

Mame: exchange_ny1

192.1.168.16

Storage resources used by hast (8)
Total capacity: 64.00 GB

IPs:

Mame

FC ports used by cluster network (4)
Balance index: 82
Mame
& 10:B0:00:00:00.
W 10:B0 00...
& 10:B0:00:00:00...
& 10:80:00:00:00..,

Utilization | Transfer... « Connected To

& fc1 on glogic_...
@ fel on brocad...

Recent Viglation Events

Capacity | Resp Time ~ 10PS Throu
B 0005 237ms | 18310/
B 0006 s800Gs 23Bms 167 I0/s
B 0002 800GE 2%Bms 187 10/s
B ool s00GE 217 ms 189 |0/s

Data center: Mew York
Applications (1)
Sea Current Generation

Business entities (1)

ighput Green Corp.Alternate Energy. Geothermal. Project

6 MB/s Mot identified by Auto Resolution

& MB/s | | 8
6 MBfs

B MB/s =

Errors

<]

I

4. Onthe Host Summary tab, click the link to any storage resource that you want to examine.

In this example, the administrator cl
time at 237 ms.

icked the 00:05 resource because it had the highest response

-+ e)Volume 00:05 12/6/12 12:00 PM — 12/7/12 1.

2:00 PM

astadn [~]
[ wrtusMschines [ vMDKs |  DalyPatterns |  SwitchPorts |  Topology |
wolume Surmmary | Diks Contending Volumes Internal Volumes | Barkend Volumes
Name 00:05 Type: Volurme
Storage: f xP 1024-1112005 Tier Silvar
Capacity. 800 GB Applications (1)
Top response time: 237 ms Sea Cument Generation
Top IOPS 188 10/s Business entities (1)
Green Corp.Altemale Energy. Geothermal, Project
Top throughput: 6 MBfs
Clients using volume (2)
Name Resp Time « 10PS Throughput
# exchange_njl 237 ms 189 10/s G MB/s
% exchange_nyl 237 ms 189 10/s 6 MB/s

FC storage ports mapped to volume (3)

Mame | Utilization |Transfer R.. « Connected To Errars
@CL. # fc5 on glogic_beta
WcL. # 18 on brocade_ga...
WCL. @ fc on glogic_alpha
Storage Pools used by volume (1)
Name Resp Time 10PS Throughput
& sP1 237 ms 754 10/ 24 MBfs

5.
on this volume is beyond the threshol

In this example in the Volume Summary tab, the administrator notices that the Top | OPS value

d (shown in red) and that the New Jersey exchange is also a

client of this volume. Click the Contending Volumes tab to examine the Volume Performance

Chart for each volume involved in th

After you finish

Identify applications that might need to b
performance problem.

Related tasks

e performance problem.

e moved to different volumes or other methods to reduce the

Determining if a VM is affecting host performance on page 30

Related references

Host Summary tab on page 52
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Volume Summary tab on page 57

Performance trend analysis

OnCommand Insight provides three tools to visualize performance trends: Performance Chart,
Distribution Chart, and Daily Performance Pattern.

The Performance Chart shows performance trends for one object over time. Use this chart to
examine the various performance metrics over the specified period and narrow your search using the
detailed information displayed when you position the mouse pointer over points in the chart. To
analyze the specific point in the chart described in the information box, right-click and select
Analyze. If you select Show Change Events, letters display on the chart with links to specific
information in the Changes list. In this example, the "A" marks when a data source was added.

% Datastore Performance Chart ds-37

0fs

WB[ s

O O N N B R

x

HAshow Change Events ) @ FF | [ (2 | TmeRranoe 7]
) M WMDK 10FS [1C)s)

o1 P @ vMDK Throughput (MB/s)
|| g o ke )

L oo
Date: 03/19 - il M

7:51:08 PM
Value: 63 MB/s

Use Right-Click To | Change... |

Analyze Performance

Datasource Added
& & 32112 6:12 PM

The Distribution Chart displays trends for several selected objects for visual comparison.

Wetic, [P Utiization -]

2 N =
8 8 &

CPU Utilization (%)
2

=
=

N
3

L]

Fri11/12100513 PW Sat11/13/10 09:00 PM Mon 11715101246 AM Tue 11716/10 04:33 AMWed 11/17/10 08:20 AM

LEY MR -E-N-NCT L

Virtual Machines
B 30
B v

O w32

The Daily Performance Pattern graph summarizes a metric over the course of a day. The graph
illustrates when there are spikes or troughs during a single day and identifies the average hourly
values for the analysis period. For switch ports, you can select multiple ports and see the collective
impact of traffic on the switch or check individual ports for periods of high or low traffic.
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. Y.L .1 - T ————C ] 2] - W
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Q} Daily Performance Pattern Performance Data; [Disk. =] metric: [tization =

8%

7%
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Identifying reasons for performance changes

You can identify possible reasons for performance changes that might be related to configuration
changes and use the change markers as research points in a Performance Chart that is linked to the
detailed change information.

Steps
1. Todisplay the Performance Chart with change markers, open any of these main views:
* Host Performance
* Virtual Machine Performance
 Datastore Performance
» Switch Port Performance
» Storage Performance
2. Select a device for which you want to examine performance details.

3. Click the Performance Chart icon for the displayed performance view.
Be certain that Show Change Eventsis checked to display change markers if that type of data is
available for the view.
Example

This Performance Chart, displayed from Datastore Performance view, includes a change marker
with a link to the change details.
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J% Datastore Performance Af (11) Groups: 5

C R T — - w—

1,906 . R = R M TN~ N

1075

72 - - il

WMDK Throughput | VMOK Top Throughput | VMDK Latency (R) | MDK Latency (W) ] VMK Latency WMDK Top Latency Storage 10PS | Storage 10}
39.0 6.0 85 ms 19 ms 105 ms 287 ms 250.010/s tl
30.00 6.00 asms 19 ms 105 ms 287 ms 250 10fs
68.0 6.0 B84 ms 19 ms 104 ms 290 ms 62.010/s
68.00 6.00 84 ms| 19 ms 104 ms 280 ms 62 10fs
= — EYEI
em Datastore Performance Chart ds-37 x
[ show change Events ) & B | (8] ([ ' Time Range

M WMok 10PS {10/s)
[ 1 VMDK Theoughput (MB/s)
E [ M VMDK Latency (ms)

| change... |

———o]

MBfs

Datasource Was Added
E‘ El 3/21/12 6:12 PM

BasoM MO RPN M MR M N A M e
1 | L | L ™ LWy

4. To show the maximum and minimum values for part of the chart, position the mouse pointer over

one of the metrics in the Performance Chart legend to the right of the chart.

Example

In this example, the maximum and minimum values for the VMDK IOPS are shown and the “A”

change marker indicates when a data source was added.

5. Click on the link beside the change marker letter to display the Changes detail view listing the

configuration changes that occurred at that time.

Related tasks

Analyzing virtual storage performance on page 36

Related references

Performance Charton page 77

Monitoring system changes that impact performance

You can identify system changes that might impact performance. Multiple changes generated from a
single event are listed with the same date and time. To reduce the number of messages displayed for
any one event in the Changes view, clear the Show transient violations check box in the Tools >

Settings for the General Preferences.

About this task

You can view the following types of physical and logical changes to SAN devices:
» Equipment additions and removals

e Zoning and volume masking changes

» Cabling reconfiguration

« Qutages

« Policy changes

Steps

1. From the OnCommand Insight Open menu, select Assurance > Changes.
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gﬁ Changes 3/1/12 9:48:00 AM - 7/1/12 10:55:00 AM (1788) @Y Tz [Eosom. [7] [ra =
Tine | Event ||
4 + IP Address identified as a Host hostAST6 (by bred_fabic) B3]
# + 1P Address identified as a Host hostAST7 (by bred_fabic)
4 + IP address identified as 3 Host hostASTS (by bred_fabic)
% + IP Address identified as a3 Host hostASTS (by bred _fabic)
3j21/12 6:13PM 99 + Hosts added to application North Africa (by admin) [E]
32112 6:13PM 94 + Hosts added to application Residential (by admin)
32112 6:13PM 99 New application Residential added (by admin)
32112 6:13PM 94 + Hosts added to application Gas Control (by admin)
32112 6:13PM 99 + Hosts added to application Usage Tracking (by admin)
3/21/12 6:13 PM g New application Usage Tracking added (by admin)
3j21f126:13PM Ty + 1 Violations created between Host cshAS1 and Storage Netipp-34 (by bred_fabic)
17 + 1 Violations created between Host csNASZ and Storage Natépp-34 {by bred_fabic)
7 + 1 Violations created between Host csNAS3 and Storage Netépp-34 by bred_fabic)
7 + 1 Violations created between Host Filer2 and Storage NetApo-24 (by bred_fabic)
7 + 1 Violations created between Host lotus and Storage Netépp-34 (by bred_fabic)
7 + 1 Violations created between Host Masltest and Storage NetApp-34 (by bred_fabic)
7 + 1 Violations resolved between Host csNAS3 and Starage Netépn-34 (by bred_fabic)
7 + 1 Violations resolved between Host [otus and Storage NetApp-34 (by bred_fabic)
T + 1 Violations resolved between Host Nasitest and Storage betapp-34 (by bred_fabic)

4% + Link removed between Storage hetApe-34 port 10:80:00:00:00:00:23:17 and Switch hibredd port fold (by bred_fabic)
32112 6:13PM 4L, + Link added between Host Nasitest port 10:80:00:00:00:00:23:90 and Switch Hbrcda part fe1 (by bred_fabic)
3f21f12 6:13PM T + 1 Violations created between Host Masitest and Storage Netapo-34 (by bred_fabic)

7 + 1 Violations resolved between Host Nasitest and Storage Netpp-34 (by bred_fabic)

4% + Link added between Host Nasltest port 10:B0:00:00:00:00:23:89 and Switch sthicdd port fo11 (by bred_fabic)
3j21f12 6:13PM T + 1 Violations created between Host Nasltest and Storage NetApp-34 (by admin)

& + 1 Paths approved between Host Nasltest and Storage NetApp-34 (by admin)
3j21/12 6:13PM  § + Host Masitest is up (by bred_fabic)

% + IP Address identified as 3 Host Mas1test (by bred_fabic)
3/21/126:13PM T + 1 Violations created between Host has2Backup and Storage [B4-7512033 (by bred_fabic)

w + 1 Violations resolved between Host Mas2Backup and Storage [BM-7512033 (by bred_fabic)

133 + Fabric/vSAN Development on principal hibredl configuration changed (by bred_fabic) E

B oy vRHefADEEFARCEIECTOVYEREGNIAA

Scroll through the list of changes to identify events that might be causing problems and click the
links in the descriptions to see more details.

If you are concerned about performance relating to the switch ports, you can open Assurance >
Switch Port Performance Alertsand select one or more items listed in red.

Click the Alertsicon to display information about the selected switches, ports, and their
connections.

If the switch thresholds need to be adjusted, right-click an item in the Switch Port Performance
Alertsview and select Configure to change the threshold settings.

Related tasks

Troubleshooting slow client computers on your network on page 32
Troubleshooting poor application performarnce on page 33

Monitoring Fibre Channel switch performance

You can examine the performance of the Fibre Channel switches in your environment and identify
risks before they turn into problems.

Steps

1

To analyze Fibre Channel switch performance, select the Open menu, select Per for mance >
Switch Port Performance.

You can use "No Grouping" or select a grouping for the data from these menu options:
 Fabric then Device

» Connected Device Type and then Name

» Connected Device

» BU then Application then Connected Device

« Application then Connected Device
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» Switch then Connected Device
» Switch then Blade
» Storage then Controller

» Storage then Node

Example

This Switch Port Performance view shows the traffic moving through switch ports. In this
example, the data is grouped by Connected Device Type and then Name.

‘3 Switch Port Performance 12/5/12 - 12/12/12 (354) Groups: 4 @ ¥ ¥ T & [Connected Device Type then...[~| [Last Week [*] &
| _Switch | SwitthPort | HassErors | Value | Rxvae | Txvaue | Distribution | Fabric/vsan|  vsan | Speed I
 Host (162) [ 4,674,115.73 GB 3,972,92... 701,187.... 57.6% 1]
® Storage (162) 1] 3,120,159.09 GB 2,652,08... 468,076.... 38.4%
= Switch (26) o 271,921.65GB 231,127.... 40,793.9... 34%
5 Switch 73 (2)Switch 72 o 64,023.32 GB 54,418.4...9,604.87 ... 23.5% 20:00:00:... 46
Switch72  feo 53,15160 GB 40,428.24,., 8,723.45 GB 90.8% 2000:000... 4
Switch 72 fc2 5,871.63 GB 4,990.22 GB 881.41GB 9.2% 20:00:00:0... 4G
= Switch 72 (2)Switch 73 o 63,750.08 GB 54,186.2...9,563.85 ... 23.4% 20:D0:00:... 4G
Switch73 0 57,055,786 GB 43,261.75... 8,694.03 GB 90.9% 2000:000... G
Switch73  fe2 570430 GB 4,024.47 GB  860.82GB 2.1% 2000:00:0... G
= hcis300 (2) scis300 1] 32,213.36 GB 27,380.9...4,832.41 ... 11.8% 46
scis300 fr2f14 16,193.21 GB 13,764.03... 2,429.17 GB 30.3% 4G
scis300 fe2/15 16,020.15 GB 13,616.92... 2,403.24 G 9.7% aG P
# hcis200 (2)  stis200 o 24,496.01 GB 20,821.2...3,674.78 ... 9.0% 46
# scis300(2)  heis300 0 17,410.656G8 14,798.6...2,612.01 ... 6.4% 46
= Switch 78 (1) Switch 79 fco i} 16,054.57 GB 13,646.1...2,408.38 ... 5.9% 20:D0:00:... 4G
# hbred1 (1) stbredl fc1s 0 10,183.44 GB 8,655.84 ... 1,527.60 ... 3.7% 20:00:00:... 26
& hbred2 (1) stbredl fco o 10,093.92 6B 8,579.75 ... 1,514.17 .. 3.7% 20:00:00:... 26
E @ F3bred-b (1) F3bred-a  fcl 0 9,970.87 GB 8,475.14 ... 1,495.73 ... 3.7% 20:00:00:... 26 EE
i i 1

3. Inthe Switch Port Performance view, select a device and right-click to select any of these options:

» Show Performance Histogram displays the relative amount of time the selected ports spent
in the given utilization levels.

« Show Daily Traffic Pattern identifies the flow of traffic by hour, day, week or by a custom
calendar setting.

» Analyze enables the correlation of data and shows trend and pattern changes.
4. To view a chart of the performance for an item in the Switch Port Performance view, select a

device or group of devices and click the Port Perfor mance Distribution icon.

Example

In this example, the selected devices are shown as individual colors in the distribution chart. The
legend on the right lists the colors associated with the devices.

5. Position the mouse pointer on points of interest in the Port Performance Distribution to display
additional time and device details.

6. To see more details, click the Performance Chart and VM Distribution icons.

Monitoring data store performance

You can monitor data store performance characteristics (such as I0PS, throughput, latency CPU, and
memory utilization) and compare storage performance with data store performance in the



18| OnCommand Insight Performance Guide

performance charts. This information helps to identify busy data stores on the V-Cluster and balance
data stores after reviewing the data store load and storage load.

Steps

1.

To analyze data store performance, select the OnCommand Insight Open menu, and then select
Perfor mance > Datastor e Per for mance.

Group the data display and select a time period, and then examine the data for any anomalies.
Select any data stores of concern, and then click the Storage Resour ce Performance Chart icon.

To display detailed information for any point in the graph, position the mouse pointer over a point
in the chart and click, or click the Pan (hand) icon to display details quickly for each point as you

move the mouse pointer over the graph.

Example
In this example, the details for an IOPS peak are displayed.

»QJ Datastore Performance Af (4] Goups: s @ EF Tz [Dswoee ~] B -] &
Name.| Virtual Center IP | VM Count | Hypervisor Count | FC Ports Capacity (GB) | Provisioned Capacity (GB) Used Capacity...| Urwsed Capacity (GE)| |
= Sym-Perf (1) ds-31 1.1.1.31 97.656 195.312 78.125 19.53%
ds-31 11131 1 2 2 9766 195.31 78.12 19.
= Wirtualizer (1) ds-30 1.1.1.30 97.656 195.312 78.125 19.5
de30 11130 19 2 1 9766 195.31 78.12 lD.j
# NTAP1 (24) 1.1.1.0,1.1.1.... 2,343.75 46875 14875 468.
# NTAP2 (6) 1.1.1.24, 1.1.... 5B85.938 1,171.875 468.75 117.14I
= NTAP-Perform (2) 1.1.132,1.1.... 195.312 390.625 156.25 39.0¢
SE-Da... 1.1.1.33 10 2 o 97.66 195.31 78.12 19.
QAD.. 11132 10 2 97.66 195.31 78.12 19.9,]
] Date: 08/13 - 11:11:43 AM O}
Value: 184 ID/s

&' Volume Performance Chart: Storage Vintualizer Volume NETAPP.20:0:VOLO

E3
use Right-Click To | show Change Events ) & (3 ) (] TmeRange[ [~
Analyze Performance 5

[ W 10es f10/s)
[ 1 Throughput (M85
[ M Respanse Time (ms)

10fs

E

Change. . 5

Ma/s

A [ Qeice Created - W

B/15/11 11:1 &M

ms

) 1) ) A YN " | | 1 )
.7_.._‘1‘\,”.7._— K A I ‘,‘H_,lu_v__,"u lj 4I_“.|7‘_r-._'_7 5, ' i — &

To analyze the performance of a selected point in a chart, right-click, and then select Analyze.

In the Datastore Summary tab, note any error messages, and then click linked items to display
more detailed information.

To examine performance information for the related VMDKS, click the VM DK S tab.

Related references

Data Store Summary tab on page 49

Monitoring storage performance

After you set performance thresholds in the OnCommand Insight Settings, you can use the Storage
Performance view to observe disk utilization, IOPS, and volume response time to identify potential

problems before a crisis.

Before you begin
The Array Performance thresholds must be established in the Global Policies section of Tools >
Settings.
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Steps

1. Open the Storage Performance view, and then group the information according to the focus of
your research.

In this example, the data is grouped by Data Center.

2. Expand the groups to show the contents of each, and then note the virtualization types, capacities,
and response times.

E":, Storage Performance Ar (:9) Groups: 4 Qa =7 I & -]
1 Narne | Technology | Y| Capacity (GB) | Raw Capacity (66) |  Vendor | Family | Model | Viokume Response Time | Volume Response Time (k) | Volume ke
= Tokyo (5) 22,318.00 34,688.00 EMC, NetApp
Sym-0000S0074300318 3,750.00 5,000.00 EMC Sym... Sym... 83 ms g1ms
NTAP-Perform FCBCSLCL.. 5,120.00 10,240.00 NetApp FASE... FASH..
Sym-0000S0074300327 3,000.00 6,000.00 EMC Sym... Sym.. 93 ms 92 ms
Sym-000050074300328 3,000.00 6,000.00 EMC Sym... Sym.. 92 ms 90 ms
CX600_29_CKO0351029329 FC 7,448.00 7,448.00 EMC Clarion  CX500 oms oms
= 2urich (6) 126,712.54 185,956.00 EMC, NetApp
APMD00310025 (V] EMC Celer... Calerr...
Symmatri-FAST 113,476.54 162,868.00 EMC Sym... Sym.. 84 ms. 82 ms
V-Series-Zuich? FOBCSLCL. @ 64.00 Netepp V-Serles V-Seras 68 ms. 67 ms.
V-Series-Zuichl FOBCSLCL. @ 64.00 Netapp V-Serigs V-Senes 70 ms 69 ms
Sym-000050074300324 (5] 3,000.00 5,000.00 EMC Sym... Sym... 78 ms 76 ms
Cx600_26_CK00351029326 FC (5] 10,108.00 18,088.00 EMC Clarion CX500 Oms Oms
= Sydney (4) 17,076.00 30,864.00 EMC, NetApp a3 ms 81ms
CX600_31_CKO0351029331 FC 4,788.00 6,384.00 EMC Clarion  CX500 oms Oms
Sym-Perf @ 2,000.00 4,000.00 EMC Sym... Sym... 80 ms. 79 ms
NTAP-Perf FCISCSLCL.. 10,240.00 20,480.00 NetApp FAS3... FAS3.. 80 ms 78'ms
Virtualizer FCBCSLCL. @ 48.00 Netapp V-Series V-Sefias 83 ms 81 ms
= New York (4) FC 21,118.00 30,108.00 EMC, HDS, HP 86 ms 85 ms
CX600_32_CKO0351029332 FC 6,118.00 10,108.00 EMC Clrion  CX600 oms oms
USP-2222112 FC 6,250.00 7,900.00HDS usp usp oms oms
USP-2222111 FC 6,250.00 7,500.00HDS usp usp Oms Oms
XP 1024-1112005 FC 2,500.00 5,000.00HP X XP10... 86 ms 85 ms
[ O]

3. Scroll across the data to examine storage of interest and its Volume Cache Hit ratios and Disk
Utilization percentages, as shown below.

E‘_—, Storage Performance Ar (19) Groups: 4 Q k¥ T a | EYR -

Je Throughput (W) | Top Volume Throughput | Volume Cache Hit Ratio | Volume Cache Hit Ratio (R) | Volume Cache Hit Ratio (W) | Volume Partial Rfw | Write Pending | Volume Accessed | Intemal Violume Re
15 MB/s 6MBfs a5% 5% 4% 20% 0 Yes
243 MB/s 92 Mefs 24% 44% 4% 20% 0 es
243 MBs. 92 MBfs 45% 44% 45% 20% 0 Yes
42 MBJs 2mBfs 0% % % (8 0 es
2,376 MBjs 1,390 MBjs 4a% 4% 4% 20% 0 Yes
1 MBfs 6 MBfs 20% 0 as
1MBs 6M8fs 20% 0 es
20 MB/s 6MBfs 44% 4% 4% 0% 0 es
10 MBjs 2m8fs 0% % % % 0 es
47 MB/s 87 MB/s 15% o Yes
S MB/s 2M8fs 0% % 0% 53 0 Ves
25 MBys 87 MBfs 4% 4% 5% 20% 0 Yes
7 MBjs 6 MBfs 20% 0 as
6 MEfs 6MBfs 20% 0 Yes
82 MB/s 6MB/s 11% 11% 11% 5% 0 Yes
8 MBjs 2m8fs 0% 0% 0% % 0 ‘es
34 MBs 2m8fs 0% 0% 0% % 0 Yes
32 MB/s 2M8fs 0% 3 0% 53 0 Ves
& MBjs 6 MBfs as% 5% 45% 20% 0 Ves

4. Select one or more storage arrays, right-click, and then select Analyze.

5. Use the tabs to see data for different devices associated with the storage, and click icons to
display more detailed information for your selections, as shown below.
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) Analyze Performance e |x|
{ ks E:; Storage Sym-000050074300328 B [F]®
Wirtual Machines | wvoks | DalvPatterns | Storage Poos | SaN Path Violations | SwitchPorts [ Topology | -
Disks | Volumes | Internal Yolumes | Backend Yolumes [ hHosts Datastores |
Disk Performance (1) Goups: ¢ @ ¥ Tz [Swee [
Hosts | Disk Size (GB} | Disk Group | Disk Speed (RPM) | Utiization | Utiization (R) | Utiization (W} | Position || |
uk_backup, uk_cust, uk_dev, ... 5,500.00 6 10000 54.23% 46.10% 8.13% (=]
Lk_backup, uk_cust, uk_dev, uk_... 5006 [54.1 46.03% [ e1%
Lk _backup, uk_cust, uk_dewy, uk_... 500 6 | 46.13% 8.13% |
Uk _backup, uk_cust, uk_dev, uk_... 5006 10000; 54.20% 46.15% 5.14% |
i —— { mc
e i -
42) Groups: 1 = - —
. All Volumes on Selected Disk (42} Goup @ £7 Tz [cow =
| Wolurne \ Label | (8]W) 18] \ Storage | Storage Pool \ Auto Tiering | Thin Provisioned Perﬂ:urmand
= Sym-000050074300328 (42) Sym-0... 5P-0, SP-1,...
0080 Sym-00... SP-0, 5P-1, .., Global
00:85 Sym-00... SP-0, 5P-1, .., Global
(i T ottt T
Qm Volume Performance Chart 07:35 on Sym-00005007 4300328 x
[Ishow Change Events <) & EB 1j =]
é 10PS [I0/5)
o Throughput [(MBfs)
o
Z W Respanse Time (ms)
[ Py | ' YV § SOy T S o o VS VO VY | N | € RINY VoW S L i Cache Hit Ratio (%)
kS ch lar lor Mar 19 |Cha$‘
9 Selected multiple elements in Al Yolumes on Selected Disk

6. If you conclude that the performance policy thresholds should not be used for individual arrays,
you can use the M odify Policy wizard to customize the global policy for those specific storage
arrays and the storage pools.

Customizing global general policies

You might want to modify global general policies, not the global SAN path policies, for special
characteristics in one area of your environment.

About this task

Using the Modify Policy wizard, you can customize the global general policies, create exceptions to
these policies, and remove exceptions to the global policies for the selected items. You can also
disable the evaluation of the parent global policy at the selected level.

Steps
1. From the OnCommand Insight Open menu, select Assurance and any of these views:
* Violations Browser
» Storage Pool Utilization Violations
» Port Balance Violations
» Policies
Or you might open any of these I nventory views:
e Hosts
» Datastores

e Storage Arrays
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* Tapes

2. Select one or more items in the selected view to examine and possibly modify the global general
policy to customize it for one area of your environment.

3. Right-click and select M odify Policy.

4. If more than one policy type applies to the selected items, these policy types are listed on the first
page of the Modify Policy wizard. Select the policy type you want to examine and possibly
change. Click Next. Otherwise, the second page is displayed.

At any point, you can return to previous pages in the wizard to review or make additional
changes.

5. Select the type of policy modification you want.

If you selected more than one item in the view, you might be modifying different settings of the
same policy, and the wizard shows that condition by listing the Current policy as “Mixed”.

6. Select a policy.
7. Click Next to save the selected modification type.

8. The third page of the wizard enables you to enter settings for the policies. Make the setting
selections and click Next.

9. The fourth and final wizard page lists the previous policy and the changes you made so that you
can review and confirm those changes.

If there were multiple policy types listed on the first page and you want to make changes to a
different policy type, select Modify another policy on the same selections on the confirmation

page.
10. Click Finish to save your changes

All changes to the policies are recorded in the Audit log.

General policy types and their hierarchies

The general policies that evaluate the elements in your environment are governed by the policy
hierarchy. All of the global general policy types have default policies that govern your environment.
You can customize the default global policies and add policy exceptions on lower-level (not global
level) components in the hierarchy.
Blocked Generic Devices
Alerts the administrator when unidentified hosts (generic devices) cannot contact any
volumes or shares.
Blocked Hosts
Alerts the administrator when a host cannot contact any volumes or shares. This policy
can only be set at the global level.
Host Port Balance
Sets the threshold for the traffic load across a device's Fibre Channel (FC) ports to be
evenly distributed. You can create a policy exception for the storage level.
Storage Pool Used Capacity
Sets the percentage threshold for the used capacity of the storage pool. You can create a
policy exception for storage array and then for storage pools.
Storage Pool Capacity Assurance

Defines the thin-provisioned storage pools (aggregate) where the sum of unused capacity
exceeds current unused space of the storage pool. A violation is generated when a storage
pool does not have enough unused capacity to accommodate remaining reserved unused
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space. By Default, three volumes need to maintain enough capacity to accommodate
unused space. Therefore, the number in the global policy is the number of volumes
required to maintain enough capacity to accommodate unused space.

Storage Pool Commit Ratio

Sets the percentage threshold for the commit ratio. You can create a policy exception for
storage and then for storage pools.

Storage Pool Utilization
Sets the threshold for the hourly average of the storage pool utilization percentage.

Storage Port Balance

Sets the threshold for the traffic on storage FC ports to be evenly distributed. You can
create a policy exception for storage array.

Storage Pool Fan-Out

Sets the number of masked hosts (generic devices) for storage ports. This policy can only
be set at the global level.

Tape Port Balance

Sets the threshold for the traffic on a tape's FC ports to be evenly distributed. You can
create a policy exception for tape.

Identifying performance trends

You can examine the OnCommand Insight performance data to see correlations between performance
and errors as well as anomalies and sudden changes in system activity to identify the trends.

Steps
1. To identify performance trends, open any of these performance views:
* Host Performance
» Virtual Machine Performance
» Datastore Performance
» Switch Port Performance
» Storage Performance
2. Select an element for which you want to see performance details.

3. Click the Performance Chart icon.

The Performance Chart legend associates the types of metrics with their colors. You can select
one or more metrics.

4. To change the period, select the time from the Time Range menu in the upper right corner.

5. Some of the metrics legends include a Change button. Click that button to select different metrics
to display on the Performance Chart.

6. You might also want to position the mouse pointer over chart points to see more information for
those points in the chart and click items in the legend to show the minimum and maximum range
in the selected value on the chart.



Examining network performance | 23

Example

This example shows the Performance Chart displayed for selected Storage Performance items
with the minimum and maximum Response Time highlighted from the legend.

F’LStorage Performance Af (4/19) Groups: 2 Q £ ¥y I=x -]

led | Disk Utiization | Disk Utilization (k.| Disk Utiization (W) | Top Disk Utiization | Disk 10PS | Disk 10PS (R) | Disk 10PS (W) | Tap Disk 10PS | Disk Throughput | Disk Throughput (R) | |

36.15% 30.73% 5.42% 89.82% 356 10fs 304 10fs 5210fs 17810fs 16 MBys 11 MBfs
36.87% 31.35% 5.52% 89.83% 36310fs 310 10fs 5310fs 178 10fs 17 MBYs 12 MBfs
31.58% 26.87% 4.71% 94.98% 621 10/s 531107s 90 10/s 189 10/s 32 MB/s 22 MB/fs
31.58% T 2ET% [ 471% 94.98% 621 10fs 531 10/s 90 I0fs 189 10fs 32 MB/s 22 MBfs
H —r [
@Ii Storage Performance Chart Vituaiizer x
[show Change Events <) & B | (&

1 M 10PS (I0/s)
[4 " Throughput [(MB/5)
M Response Time (ms) |

10fs

| Change... \

MB/s

W

A i ol
MM li‘, f i ‘l,‘ T 4‘\":-,“{; [ | M-‘w‘-g A
M u, \ | WL, Ll [R
S U | b ¥ = |

Related references

Storage Performance view on page 82
Performance Charton page 77

Exporting performance data as an image or file

You can export any of the Performance or Distribution charts as images and to comma-separated
values (csv) files for import to Excel and other tools.

Steps

1. Display performance data in a Performance Chart or Performance Distribution chart for one of
the performance views.

2. Inthe upper right corner of the view, click one of these icons:
* Export asimageto File
» Export Raw Datato CSV File
3. Inthe Windows dialog box, select a directory and enter the name of the file you are creating.

4. Depending on the type of file you are creating, click Save for the image file or Export for the
CSV file.

If you exported the data as a CSV file, the format is Date, Element name, and Metric Value.

Related references

Performance Charton page 77
Performance Distribution view on page 79
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Grouping data in views

You can classify and group the data in a view table so that you can interpret the data in groups that
you specify. For example, you can group switches data by fabric.

Steps

1. Inthe right of any view, click the Grouping drop-down list.

- FCPorts (1) x
” Q ¥ Iax |

| Marne. | Connected to | Fabric/vsan | State | Status | vendor Status | Type | Spee No Grouping

= Chicago-Host2 (1)  10:B... & Online & 0K N-Port 4G | Device Name:

Connected Device Mame

10:8,,, Switch Switch 25, port f0 20 p0:000... @ Orline @ OK POt 4G | copic Then Device

2. Select a data grouping.

3. To remove the grouped display from the table, select "No Grouping" from the Grouping drop-
down list.

Note: You can also group data according to annotation groups. Using annotation groups, you
can assign custom business-specific categories to resources and then group the resources by
those categories. For example, on the Hosts view, you can group the data by names of your data
centers so that you can see all resources for each data center.

Example of grouped data
The following example shows the Zone Members detail view with the Zone grouping.

If you do not group data, the data appears on one row per resource. On the other hand, if you
do group the data, OnCommand Insight adds a column to the left of the table with grouping
information. The number in parentheses after each grouping level represents the number of
items reported in that grouped row.

Qﬁ Zone Members (24) Groups: 12 _ x
; @ T Tz [zre
| Zone Wame | Fabric/vSan | Device Type.| Device Mame | Status | e
= Zone 109 (2) Zone 109 20:D0:00:00:00:00:00:67 (...
Zone 109 20:00:00:00:00:00:00:67 (fab... Host uk_exch Fort connected  (py 10:50:00:00 -
Zone 109 20:00:00:00:00:00:00:67 (fab... Storage C¥600_29_ckoa... Port connected oo portin
Zone 110 (2) Zone 110 20:D0:00:00:00:00:00:68 (...
[= Zone 115 (2) Zone 115 20:D0:00:00:00:00:00:67 (...
Zane 115 20:D0:00:00:00:00: 0067 [fab... Host uk_Fust Fort connected (o) 10:50:00:00E|
4] ] s — D]
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Monitoring virtual machine performance

Virtual machine (VM) administrators need to examine contention with VM resources and look for
locations for new VMS.

VM administrators can use OnCommand Insight to research the following:

+ Determine where to add a new VM.

» Determining if there is any VM contention related to 1/0O or memory utilization.
» Select an active path for a VM datastore based on low port utilization.

e Add a host to a virtual cluster to share an existing datastore.

» Determine whether a VM is responsible for a host performance issue.

Viewing virtual machine performance and utilization

Storage administrators often need to look for inactive virtual machines or virtual machines that are
using high tier storage that could be using a lower tier storage. Using OnCommand Insight, you can
view virtual machine performance and utilization. When all virtual disks are in NFS/iSCSI backend
data stores, you can also see traffic going to individual virtual disks attached to a virtual machine.

About this task

The Virtual Machine Performance view does not display information about virtual machines and
LUNSs that do not map to a volume.

The colors that display on virtual machine performance views reflect the settings on the VM Hosts
Thresholds view in Tools > Settings.

Steps
1. From the OnCommand Insight Open menu, select Performance > Virtual Machine
Performance.
"/; Virtual Machine Performance Af (30) Q@ %£7F Ta [)Ncoong [=] [ -] &
Mame.| OMS Name | Host Mames | Datastore | v-Cluster | CPU Utiization | Memory Utiization | Disk Latency (R) | Disk Latency (w) | Disk Latency | Top Disk Latency | Disk I0PS (R} | Disk 10P |
W60 vm-60.003... esxl d5-30 Cluster 1 85.4% B5.8% 83ms 19 ms 102 ms 277 me. 7110/ U=
[om-61 vme61.0na... esx3 ds-31 Cluster 2 84.2% B7.4% 87 ms 19ms 107 ms. 284 ms. 7110/s 1
vm-62 vm-62.0na... esxl ds-30 Cluster 1 B.7% 23.4% ams ams oms 1ms 010fs
vm-63 vm-53.0ma... esx2 ds-30 Cluster 1 8.9% 23.5% Oms oms Oms 1ms 010fs
in-64  vM-64.0n3... e5H3 ds-31 Cluster 2 B.6% 23.3% 0ms oms oms 1ms 010fs
65  vm-65.0na.., eskd ds-31 Cluster 2 8.7% 23.7% oms oms oms 1ms 010fs
vm-66 vm-66.0na... esxl ds-30 Cluster 1 B.7% 23.7% 0ms ams oms 1ms 010fs

2. Inthe Virtual Machine Perfor mance view, optionally, select one of the following options to
group the data in the view:

e Host

» Datastore

* V-Cluster then Host

» V-Cluster then Datastore

3. To determine whether there are anomalies or sudden changes in the virtual machines over time,
click on the Performance Chart icon in the status bar.
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8 Virtual Machine Performance Chart X
Eishow change Events ) X BH ' [ (3 | TmeRangel 7]
1M WMOK 10PS (10/5) =

[327.65%
[0 wMOk Throughput (MB/5)

| C1 VMOK Latency fms) i
9 [CPU Utiization (%) i

W Mernory Utiization (9)

[Tchenge... | &l

I Bpchication Chanped
|| (B i Thar A

I Datasource Added
6/15/11 1L:41 AM

[P Identify - WWI =
o |G R

4. To see traffic distribution on the virtual machine, click the Perfor mance Distribution view icon.

VM Performance Distribution x
metric:  [CPU Utilzation 1B@a
600 Virtual Machines
W vme0
S00 & v
2400
5
= 300
5
g 200
100
]
Tue Aug 9 10:26 AM Wed Aug 10 2:13 PM Thu Aug 11 6:00 FM Fri g 12 946 P Sun Aug 14 1:33 AM Mon Aug 15 5:20 AM

Related references

Performance Distribution view on page 79

Setting virtual machine thresholds

Set the range of Hypervisor (HV) performance threshold values that show up in green, yellow, or red
on the Host Performance view, which displays the HV utilization of virtual machine (VM) hosts
(ESX servers) over a selected period.

About this task

For each threshold, you set high and low values. After you set the threshold, severity is represented
on the Host Performance view using the following colors:

» Green: Values below the threshold's low value.
» Yellow: Values below the threshold's high value, but above the threshold's low value.
* Red: Other values, such as those above the threshold's high value.

The settings on this view affect the colors on the following views: Datastore Performance view,
Virtual Machine Performance view, VMDK view, and Host Performance view.

Steps

1. From the Client menu, select Tools > Settings.

2. In the left tree of the Settings, click Thresholds> VM Hosts Thresholds option.
3. For each threshold set low and high limits:

» Latency: Average amount of time for a read/write operation from or to the virtual disk before
an alert is issued. The default values are Low 20 and High 100.
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» CPU Utilization: Threshold for the host's CPU MHz being used. The default values are Low
45 and High 75.

« Memory Utilization: Threshold for the memory used by the host. The default values are Low
35 and High 65.

To save settings on this one view and continue with other settings, click Apply.

Click OK.

Determining where to add a data store to achieve load
balancing

The virtualization administrator (VA) can add a new data store to a single host or a cluster and
achieve load balancing.

About this task

The major steps are:

The VA asks the storage administrator (SA) to allocate the capacity and enable access from the
hosts.

The SA allocates the capacity and configures the storage array and SAN switches to enable
multiple redundant paths.

The VA creates a data store on the allocated volume.

The VA chooses the preferred paths to achieve load balancing while avoiding path thrashing.

Steps

1
2.

© © N o

10.
11.

Allocate some capacity and configure access for a group of hosts.

To identify existing volume allocations for the hosts, select I nventory > Hosts.

This information supports your decision for volume allocation. You might choose storage arrays
that are already zoned, for example.

Allocate a new volume.

To choose the storage port and storage processor that will allow for a balanced load, select
Performance > Switch Port Performance.

Configure the storage array and fabric switches to enable all hosts to access the volume through
multiple paths.

To verify that all hosts have access to the volume, select Inventory > Hosts.
Create a data store on the new volume and configure the preferred path from the hosts.
Select Inventory > Virtual Machines.

From the Virtual Machines view, click the Virtual Machines Disks icon in the status bar to show
the VM DK s detail view.

Verify that the data store was added to all hosts in the cluster.
To set a global policy, do the following:

a. Select Tools> Settings.



28| OnCommand Insight Performance Guide

Selecting an active path for a virtual machine data store

Use OnCommand Insight to determine which active path to set for a virtual machine (data store). You
should look for a low utilization storage port.

b. In the Policies list, select Host Virtualization.
1 CnCommand Insight Settings C4EdEd
i|T—E|{ Annotations 7| : e .
- Rules = | Host Virtualization Policy
- Types
Auto Resolution Activate and configure host virtualization rules
- Cost Accounting
— Data Sources 2 e "
[=tsss it b FE Single storage processor for volume active paths
=+ Policies O EMC/CX 600
FC Global Path O EMC/Celerra NS-480
[ 3okl Bolities Storage Models: O EMC/Symmetriz DMX800
t B e
ISCST Global Path O HR/HP 1024
|~ Reservations
i x!ulat!un NUt'ﬁE.at":'n Identical volume access for hosts within a virtual duster
inlation Severity
-Profiles 5
& Threshoids Identical volurne LUM for hosts within a virtual custer
|~ 8witch Thresholds
- WM Hosts Thresholds
| apay
Help Ok | | Cancel |
c. Set the Host Virtualization global policy that will continuously verify that the hosts have

sufficient redundant access to the volume and that the conditions for path thrashing do not

occur.

About this task

Look for low storage port utilization on the storage array on which the virtual machine was allocated
(for a new data store) or for the storage processor that is already being used for access by other ESX
servers (for an existing data store and a new ESX server).

Steps

1. From the OnCommand Insight Open menu, select Performance > Switch Port Performance.

Path thrashing might be caused by conflicting selections of preferred paths.

+ Switch (26)
= Storage (125)
= San Antonio (2)
Switth 36
Switch 37

Switch 34
Switth 35

* Philadelphia {2)

¥ V-Series-2urich...

¥ Dallas (2)

# Jacksonwille (2)

# Sym-00005007...

# NTAP2 (2)

¥ V-Series-Zurich...

¥ Detroit (2)

¥ Sym-00005007...

oo u A~ W D

k1
k1

k1
k1

253,060,792 MB
2,146,240,113 MB
616,263 M8
12,254 M8
604,000 M8
618,446 MB
606,047 MB
12,400 M8
1,426,061 MB
2,608,473 MB
5,862,106 MB
5,920,484 MB
6,356,391 M8
7,321,201 MB
8,138,647 MB
8232411 MB
14,005,236 MB

Filter for storage arrays.

‘: Switch Port Performance Trafic 1/30/12 - 2/6/12 (293) Groups: 4
Swich | swichport]  vaie | Dstbuton | Fabac | veen

50%
424%
0.0%
20%
EX
0.0%
.o
20%
1%
0.1%
0.3%
0.3%
0.3%
03%
DA%
0.4%
0.7%

L]

20:00:00.
20.00:00.

20:00:00,
20:00:00..

¥
| Port Speed | Switchelade | |

T & [0 connected Devica Typa then Name

~] stk 7] fufic 7]

a1
a1

Port Controler | Transfier Rate | CorrectedDevice Type | Cod |

1,170.86 M... Switch
5.974.98 ... Storage
349 MB/S Storage
0.07 MBfs sterage
3.42 MBS storage
3.51 MB/5 Storage
344 MBJs Storage
0.07 MEJs Storage
.08 MB/5 Storage
15.30 MB/S Storage
33.23 MB/s storage
33.56 MB/5 Storage
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4150 MB/S storage
46.14 MB/S Storage
46.67 MB/S Storage
79.90 MB/s Storage

Click the Port Performance Distribution icon in the status bar.
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Phoen:
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Phosree
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Sym-000
NTAP2
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O]

From the Switch Port Perfor mance view, select "Last week" as the timescale.

Select the storage device with the data store volume or volumes. Select multiple devices.

If you need a longer historical view, in the Switch Port Perfor mance view, adjust the time.
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Identify storage ports that have the least utilization. Check for connectivity to the same fabric if
the host is already connected.

Adding a host to a virtual cluster to share a data store

The virtualization administrator (VA) can add a new host to a group of hosts in a virtual cluster and
share an existing data store.

About this task

The major steps for adding a host to a virtual cluster to share a data store are:

The VA asks the storage administrator (SA) to grant the host access to the SAN volumes on a data
store.

The SA configures the storage array and SAN switches to enable multiple redundant paths.

The VA adds the data store to the host and chooses the preferred paths to achieve load balancing
and avoid path thrashing.

Steps
1. Ask the system administrator to grant you host access rights to the volumes on a data store.
2. To identify which storage ports and processors are being used to access this data store by existing
hosts, select I nventory > Hosts
3. To identify the storage port and storage processor that will allow for a balanced load and choose
the correct mapping to avoid path thrashing, select Performance > Switch Port Performance.
%SWi'Ch Port Performance 12/5/12 - 12/12/12 (354) Groups: 4 @ ¥ ¥ I =& [CornectedDevice Type then...[~|  [ast Week [] €&
| Switch |  SwitchPort | HasErors | Valug | Revalue | Tevaue | Distribiuition | Fabricjvsan | wvsan | Speed 1]
# Host (162) 0 4,674,115.73 GB 3,972,92... 701,187.... 57.6% (4]
[ Storage {162) o 3,120,159.09 GB 2,652,08... 468,076.... 38.4%
= Switch (26) 0 271,921.65GB 231,127.... 40,793.9... 3.4%
= Switch 73 (2)Switch 72 1]} 64,023.32 GB 54,418.4...9,604.87 ... 23.5% 20:D0:00:... 4G
Switch 72 fco 58,151.69 GB 49,428.24... 8,723.45GB 90.8% 20:00:00:0... 4G
Switch 72 fc2 5,871.63 GB 4,090.22 GE 881.41GB 9.2% 20:00:00:0... 4G
= Switch 72 (2)Switch 73 o 63,750.08 GB 54,186.2...9,563.85 ... 23.4% 20:D0:00:... 4G
Switch 73 fe 57,955.78 GB 49,261.75... 8,694,03 GB 90.9% 20:00:00:0... 4G
Switch 73 fr2 5,794.30 GB 4,924.47 GB 869.82 GB 9.1% 20:00:00:0... 4G
= hcis300 (2) scis300 1] 32,213.36 GB 27,380.9...4,832.41 ... 11.8% 4G
5cis300 fr2f14 16,192.21 GB 13,764.02... 2,420.17 GB 50.3% 4G I
5cis300 fe2/15 16,020.15 GB 13,616.92... 2,403.24 GB 49.7% 4G
# heis200(2) scs200 1] 24,496.01 GB 20,821.2...3,674.78 ... 9.0% 4G
® scis300 (2)  heis300 0 17,410.65GB 14,798.6...2,612.01 ... 6.4% 4G
& Switch 78 (1) Switch 79 fc0 o 16,054.57 GB 13,646.1...2,408.38 ... 5.9% 20:D0:00:... 4G
# hbred1 (1)  stbredl fcls o 10,183.44 GB 8,655.84 ... 1,527 .60 ... 3.7% 20:D0:00:... 26
# hbred2 (1) stbredl fco i} 10,093.92 GB 8,579.75 ...1,514.17 ... 3.7% 20:D0:00:... 2G
@ F3bred-b (1) F3bred-a fc1 o 9,970.87 GB 8,475.14 ... 1,495.73 ... 3.7% 20:00:00:... 2G /3
| T ] 5]
4. Configure the storage array and fabric switches to enable all hosts to access the volume through
multiple paths.
5. To verify that all hosts have access to the volume, select I nventory > Hosts.
6. Create a data store on the new volume and configure the preferred path from the hosts.
7. Select Inventory > Virtual Machines to display the Virtual Machines view.
8. From the Virtual Machines view, click on a virtual machine and click the VM DK s icon to show

the virtual machine disks.
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9. Verify that the data store was added to all hosts in the cluster.

10. Verify that there is no active path conflict (in the event of an active/passive storage array).

Determining if a VM is affecting host performance

If a customer calls to complain that response time is unacceptable, you need to find the VM to
determine whether it is responsible for the performance issue. For this example, the host name is
NtapESX-2, the IP address is 192.1.168.39, and the name of the VM is vm-15.

Steps

1. Enter the name of the host, VM, or IP address into the Search facility.

In this example, the search results for the VM name show that only one VM matches the search

criteria.
|C{ yrm-15 ®
Best Match | "ESX2VM-MAS4" (vm-15) Red Hat Enterprise Linux S (64-bit)
VirtualMachine = "ESX2VM-MNAS4" (vm-15) Red Hat Enterprise Linux 5 (64-bit)

2. Double-click the selection in the search results that is most likely the VM you want to investigate.

The Virtual Machine Summary tab displays troubleshooting information.

0y Analyze Performance L4 B4
=7 Virtual Machine ESX2VM-NAS4 12/19/12 1:00 PM - 12/20/12 1,00 PM )
Contending Vitual Machines | VMDKs | DafyPatterns | SANPathViolations | Switch Ports Tapology
Wirtual Machine Summary | Disks | voumes | InterralVolumes |  BackendVolumes | Hosts |  Datastores
MName: ESX2VIWV-NASA Applications (1)
CPU utilization: off Juice
iapESK.2 Business entities (1)
4 Qrange Corp.Distributors.Central. Sales

not defined
not defined
10

»¥ virtual machine (2)
ty 252 GB of 98.13 GB tatal (3%)

lame Capacity Latency = | Storage Resou

& ESX2VM-NASH_2... 0.00 GB of 49.20 GE tota... 8 NTAP1-Vall
£ ESX2VM-NASA_1 .. 0.00 GB of 48.93 GE tota... 8] NTAP1-Valt
Datastores used by virtual machine {1)
Name = Capacity
/8 DS-MiapESX2 976,61 GB of 1,464.95 GB totd (57%)

3. Check to be certain that the correct business entity is represented in the summary and examine the
data.

In this example, the summary shows that the Juice Sales application is running on this VM, and
the CPU utilization is Off. That is an obvious problem, but what is the cause?

4. Based on the VM summary information, you might examine details on other tabs in the Analyze
dialog box, or you might select the Inventory > Virtual Machinesto view the VMs as a group
and locate the one you have researched.

In this example using the Virtual Machine view, the state of the VM is "Shutting Down" and that
VM has the smallest capacity of the VMs listed. This information reveals a problem with the way
the Juice Sales application was set up since it is a High priority application.
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</ Virtual Machines (2%) Goups: s Q E¥F Ta
Hame | | )13 | Hosthames |  bostiPs | VM Capacity (GB) |VMUsed Capacity (5B)| VM Merory (MB) | State 2| Appication | d_|
[ESHIVM-NASS ¥m-S NtapESX-1 192.1.168.38 4377 10.42 6144 Unknown lice Saes  High =
= NtapESX-2 (10) NtapESx-2 192.1.168.39 3,190.14 97.83 43,008 Juice High
s nas2 12 NtapESK-2 192.1.168.39 24557 793 2048 Not Rurring ice Hgh
[ESX2VM-NASS vmn-13 NtapESX-2 192.1.168.39 196.16 633 4096 Resetting Juce High
[ESX2VM-NASS ¥in-14 NtapESK-2 192.1.168.39 303.14 10.62 6144 Rurning duce High
[ESH2VM-NASH ¥-8 NUpESK-2. 192.1.168.39 34315 10.74 6144 Rurning duce High 1]
Es@viNASH s HtapESH-2 192.1.168.39 %813 252 2049 Shutting Cawn ics Hgh m
[ESH2VM-NASS vm-8 NtapESX-2 192.1.168.39 49120 1535 2048 Shutting Dawn Juce High
[ESHZVM-NAS Vm-16 NtapESX-2 192.1.168.39 441.50 .98 4006 Standby Juice High
[ESHZVM-NASS vm-10 NtapESX-2. 192.1.168.39 3433 10.09 4096 Standoy Juice High
[ESH2VM-MNAS2 ym-17 NtapESX-2 192.1.168.39 441.87 1473 6144 Unknown Juce High
[ESX2VM-NAS3 vm-11 NtapESX-2 192.1.168.39 195.96 654 6144 Unknown Juce High
£ NtapESX-3 (18) NtapESx-3 192.1.168.40 5,005.94 140.30 73,728 Juice High
[ESXIVM-NAST 18 NEpESK-3 192.1.168.40 34315 11.07 2048 Not Rurning duce High
[ESHIVIMNAST vm-24 NEDESK-2 192.1.168.40 196.23 594 2048 Not Running Jice High
ESXaVMMAST vn30 tapESK-3 192.1.168.40 224 1032 2048 Not Rurring ice Hgh 5
£l D

At this point, you can respond to the inquiry.

Based on the research in this example, you conclude that the Juice Sales application needs to be
moved to a larger capacity VM, and you inform the team and plan for that change.
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Troubleshooting performance problems

When you receive calls reporting performance problems, OnCommand Insight provides the tools to
use the reported facts along with your experience to track down the source of the problems.

While OnCommand Insight cannot describe the precise solution to a performance problem, it does
give you tools enough to determine the best troubleshooting action based on information found in
OnCommand Insight.

Troubleshooting slow client computers on your network

If you receive many calls from network users complaining that their computers are running slowly,
you can troubleshoot host performance and identify the affected resources.

Steps

1. From the OnCommand Insight Open menu, select Performance > Host Performance.

2. Look for hosts with a high percentage of memory utilization. Select a host in this view.

3. Right-click and select Analyze.

4. Inthe Host Summary tab, check to be certain that the Data Center and Applications, shown on

the right, are the ones with the reported slow client computers.

@ Analyze Performance ks
P>
S ) Host exchange_ny1 12//12 12:00 PM - 12/7/12 12:00 PM Lstzeh [~]@
Datastores | VirtualMachines | wMDKs | DalyPattems | SAN Path Violations [ SwitchPorts | Topology
Host Summary Disks | volumes [ Intemal Volimes I Backend volumes Hosts
Name: exchange_ny1 Data center: New York
1Ps 192.1.168.16 Rpplications (1)
— Sea Current Generation
apa Business entities (1)
- Capacity Resp Tiria * 1oPS Throughput Green Corp.Alternate Energy. Geothermal Project
B 0005 BOOGE 237 ms 188 [0/s 6 MB/s [+ hlot identified by Auto Resolution
B 0006 800G 235 ms 187 10/ EMB/s ||
B 0002 s00G8 2/ms 187 10/s 6 MBfs
B 0001 so0GB 217ms  18310/s BB/ )
FC po cluster network (4)
Bal
Mame Utilization | Trang Connected To Errors
% 10:B0:00:00:00 ]
% 10:60:00:00:00... = fc1 on glogic_.
&% 10:B0:00:00:00... @ fc1 on brocad..
% 10:80:00:00:00 L
Recent Wiolation Events
<] ]

5. Click the link for the volume with a high response time or click the Switch Portstab to examine
a high transfer rate.

6. Determine the appropriate corrective action for your environment.

Related references

Analyze dialog box on page 47
Host Summary tab on page 52
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Troubleshooting poor application performance

Suppose the manager in a business unit called to complain that the application they are running is
performing poorly. You can analyze the situation to identify the source of the problem and determine
whether the poor performance is caused by the network or the application itself.

Steps

1. From the OnCommand Insight Open menu, select Performance > Host Perfor mance to see the

performance data for all of the hosts.
2. Select the server for the Data Center and

3. Right-click and select Analyze.

Application that had a performance problem.

4. Inthe Host Summary tab, look for any high response times or a high transfer rates in the cluster
FC network. Click the link to the volume with a high response time or transfer rate.

In this example, the storage resource has an IOPS of 114 10/s that violates the performance

threshold.
Analyze Performance 4l b4
&
o] Host esxd 12/6/12 12:00 P — 12/7/12 12:00 PM Gten 1@
VituaslMachines | WMDKs | DalyPattems | SanPathwioktions |  SwitchPorts |  Topology
Host Summary Disks [ Vollmes | Intemal Volumes Backend Volumes
{ esxd ter. Sydney Tl
P 1921.168.88 a
Bus ities
chkily | REsETIRG ¥ oPS rhiGiihei Green Corp.Waste Management. Wasteland Rehabilitation. Project
B 00W 320068 2ims [ 114105 14 MBIz i Resolut
8 W05 320068 <ims <l 10fs 2 MBis
@10 320068 <1 ms <1105 2 MB/s
p i by cluster network (2
B:
tiliza Connected To | Ermors
10:60:00.00:00:... a fc1 on Swi Ll
10:B0:00.00:00 & fc0 on Swi
[=]
0] ||

5. Click the link of the storage resource that is above the threshold.

6. In this example, the Volume Summary tab displays the resource details and indicates that there
are no data sources. The error message and "No data sources" indicate that the data sources have
stopped collecting data. This failure might not be the source of the performance problem, but

rather the result of that problem.
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GEiE

o E,Volume 00:00 12/6/12 12:00 PM = 12/7/12 12:00FM on Fe
Backend Volumes Hosts Datastores a Switch Ports onolgy
Wolume Summary Internal Volumes

1\ Data is not beifig colfected

Name: 00:00 Type Meta
Storage O sym-Per Tier Gold-Fast
Capacity: 3200 GB Applications (1)

Top response time: 27 ms Gas Control

Top I0PS: 114 10fe Business entities (1)
Green Corp. Waste Management Wasteland Rehabilitation Project
Top throughput: 14 MB/s
) No data sources
Clients using volume (2)
Name Resp Time I0PS Throughput

M esxt 2 ms 114 1075 14 MBls
M el 2 ms 1141075 14 MBls
FC storage porls mapped to volume (3)
Name Utilization  Transfer R Connected To Errors.
@ FAAPo. & c0 on Switc
@ FAAPD. & c0 on Switc
W FAIAPO. & fcD on Switc
Storage Pools used by volume (2)
Name Resp Time = IoPS Throughput
& sP0 T me 236 10fs 60 MBfs
Espa 7 me 236 10fs 60 MBfs

7. At this point, the technical team must explore the data source failure.

Related references

Host Performance view on page 70
Volume Summary tab on page 57
Host Summary tab on page 52
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Analyzing traffic flow and identifying congestion

Smooth traffic flow and preventing congestion on a storage network device or across devices is a
primary concern of administrators. Storage network congestion often impacts service levels and
might cause application failures.

Storage network traffic is unpredictable. Depending on an application’s demands, the amount of data
flowing from hosts through switches, ISLs, and storage arrays can fluctuate greatly. While some
applications send and receive less data over time, others send and receive vastly increasing amounts.

Hosts are a crucial part of the storage network because they house the applications that perform vital
business operations. When a host becomes congested, business applications experience degraded
performance or fail. You can use these OnCommand Insight tools to analyze traffic flow and pinpoint
areas of congestion to prevent many problems:

» Switch Port Performance

e Analyze

» Switch Port Performance Alerts
« Daily Traffic Pattern chart

* Host Performance

Identifying a congested host

Many times you might suspect that a congested host is the result of a slow switch or over-utilized
volume, when in reality, the host is congested because other hosts are over-utilizing the same storage
port. You can identify a congested host and the cause of the congestion by noting errors occurring on
all hosts. Hosts receiving errors are likely experiencing congestion.

About this task

If you already know the name of the problem host, skip this procedure.

Steps
1. From the OnCommand Insight Open menu, select Performance > Switch Port Perfor mance.

2. From the menus in the upper right corner, select Connected Device Type then Name and L ast
Week.

This displays all connected devices including storage devices and the amount of data traffic in
Megabytes per storage device.

3. Expand the list of Hosts.

4. To examine the errors on each host in the Has Errors column, select a host with a high number of
errors and a high amount of data traffic as a potential candidate.

5. To copy the host name, click the host name in the first column and press Ctrl+C to copy the host
name into your computer Clipboard.

After you finish

You need the Connected Device Name of the potential congested host in your Clipboard to start the
analysis of the host congestion.
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Analyzing congested storage ports

When a storage port becomes congested, hosts experience degraded performance, and application
performance also suffers. You can locate congested storage ports, analyze the cause of the
congestion, identify SAN devices most likely responsible for the congestion, and solve the problem.
The two most common causes of congestion are a high amount of host data traffic (from a busy
application) accessing a volume through the storage port or a malfunctioning switch port.

Steps

1. From the OnCommand Insight Open menu, select Performance > Switch Port Performance.

2. From the three drop-down lists in the upper right corner, select Connected Device Type then
Name, Last Week, and Traffic.

3. Expand the Storage group to locate a potential candidate with a high number of errors and a high
amount of data traffic.

4. Expand the storage array and write down the name of the storage array ports or select an
individual port.
To copy the storage name, click the storage name in the Connected Device Name column and
press Ctrl+C.

5. From the OnCommand Insight Open menu, select I nventory > Storage Arrays.

6. To sort the storage devices by name, click the Name column heading.

7. Paste the copied name of the problem storage array into the filter by pressing Ctrl+V. Press
Enter.

8. Click the FC Portsicon.

9. Right-click on the storage array port and select the Show Daily Traffic Pattern option to display

the Histogram View for the port.

Review the list of all the devices (by type) that access the congested storage port. The congested
storage port also appears. The amount of data flowing through these devices to all storage arrays
is displayed. The host displaying the most data traffic is the probable cause of the storage port’s
congestion.

Analyzing virtual storage performance

You can identify the source of performance problems on the virtualizer, on the virtual disks used by
the virtualizer, and on the virtual volumes and internal volumes created by the virtualizer.

Steps

1. From the OnCommand Insight Open menu, select Perfor mance > Stor age Performance.

2. Filter the columns in the view to show only the virtualized storage.

3. Examine the data for any anomalies, particularly in the utilization columns.
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?b" Storage Perfurmance A (4/19) Groups: 2 Q ¥y = .} w D £
36.15% 30.73% 5.42% 89.82% 356 10/s 304 1075 5210fs 178105 16 MBfs 11 MBfs
36.87% 31.35% 5.52% 89.83% 363 10/5 31010/s 53 10f5 178 10/5 17 MBfs 12 MBfs
31.58% 26.87% 4.71% 94.98% 62110/s  53110/s 90 10/s 189 10/s 32 MB/s 22 MB/s

[ Gusew [ e | a7 [ wasen  ezlos 53110/ 9010/ 189 10/5 32 MBfs 22 MBfs
o o
Disk Performance (10) Groups: 1 x Storage Performance Chart Vituaiizer x
¥ T & Cshow change Events ) & [ [ &
HMame Storage (V] Hosts) 400
& Virtualizer (m)J J\muaumr [esxl, esx2 ~[ ol & FRE T M !‘ iy 2 W 10PS (10/5)
DISK-10 Virtualzer O e, e 9 ‘ IR IASIRRL! THoUghne ae)
DISK-11 Virtualzer G et es2 : : Sl e Ao, B MResiors Tine (i
DISK-12 Yirtualizer LV IS ‘E
DISK-13 Virtualizer U e, esx2 s 1
DISK-14 Virtualzer O et e *
DISK-15 Virtualizer U e, enn2
DISK-16 Yirtualizer O ex1, es2
DISK-17 Virtualizer U esxi, es2 lv
4 NISK-18 Vet alizer 8 ot e E‘El t ; ~ m

Click icons to display detail views, as shown in the image.

Click the links in the performance chart to display the changes for each event and to determine
which events caused the problems.

For more details about associated resources, right-click an item of interest in a table and select
either Analyze or Analyze Storage Pools.
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Balancing resources

A key goal for the storage administrator is to use capacity in a proactive way to avoid problems like
contention for resources. Administrators need to predict and prevent these problems. You can use
OnCommand Insight to analyze the network traffic on your storage network as well as the
distribution of that traffic on all devices and ports and determine how to balance the data flow among

them.

Balancing the data flow means extracting more utilization out of the storage network without

impacting application performance.

Analyzing port balance violations

When examining port balance violations, you need to determine whether the violations indicate

ongoing problems or temporary conditions.

Steps

1. To examine the list of host port balance violations, select Assurance > Violations Browser.

2.
3.

In the browser tree, expand All Violations and select Host Port Balance.

Click the Violation Event icon to see an overview of the port traffic balance over time.

Click the Impact Details view to see the resources impacted by the port balance violation.

Violation Summary

300,000

Host dev2 had 3 FC port balance index 088 exceeding thieshold of 50

T Violations List Arviowtions: Al Vioiations, Type: Host Port Baiance (39) Groups. 1 @ EY =& [Dswew [+
- | Efement | Description | Severity | ViolaionType | |
;i WL 1 Port of 51 on exceeds the 3 mverage Host Port Balance  Maxir
::zﬁ:g;‘:;‘:;i:““ 1 port or52on exceeds the 3 Average  HostPor Balance  Mair
it HoslcsNAS?  |Portbalance index of 51 on Host csNASZ exceeds the threshold of 50 3mverage  HostPorlBalance  Maxir
pacied Virtsal Machine HoslcsNAS?  [Portbalance index of 52 on Host csNASZ exceeds the threshold of 50 3mwerage  HostPoriBalance Mai
4 Impacted Storage Array HoslcsNASI |Port balance index of 7 on Host csNAS3 exceeds the threshold of 50 3mverage  HoslPoriBalance  Mai
4 Data Centar Host dev! Port balance index of 84 on Host devl exceeds the threshold of 50 3average  HoslPoriBalance  Mai
= All Violations (2,487) Host dev2 Port’ of 35 on |3: mverage Host PorBalance  Masin -
Disk Utilization (2.440) Hostesx Port balance index of 33 on Host esx1 exceeds the threshold of 50 3 Average Host Pori Balance  Maxir &
HostPort Balance (39) Hoslesx2 Port balance index of 93 on Host esx2 exceeds the threshold of 50 3 Average Hos! Porl Balance  Mazi
::::::: :;‘g‘i;f:g)m“m Hostexchange_...Port balance Index of 74 on Host exchange_ni1 exceeds the threshold of 50 3 Average Hos! Port Balance  Mazi
Hostexchange_...|Port balance index of 93 on Host exchange_ny! exceeds the threshold of 50 3Average  HoslPortBalance Mai
HostFederer  Port balance index of $1 on Host Federer exceeds the threshold of 50 JAverage  HoslPortBalance Maxir
HostFederer  Port balance index of 54 on Host Federer exceeds the threshald of 50 JAverage  HostPortBalance Mawir
HostFiler! Port balance index of 100 on Host Filer! exceeds the threshold of 50 JAverage  HostPortBalance Mawir
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5. Select one violation of interest, right-click, and select the Analyze option.

Example

In this example, the Host Summary tab shows that one volume has a response time beyond the

threshold.
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6. Click the link to the display more details for the volume with the high response time.

Select the Contending Volumes and Daily Patternstabs to determine if the out-of-balance
condition is a trend or a special case.

7.

After you finish

If the port traffic over the device is permitted to be out-of-balance, you can modify the policy on the
device to increase the balance index threshold or disable the policy on the device completely to
eliminate the violation.

Identifying out-of-balance network traffic across host ports

If the ports of a host are connected and active but some are transmitting or receiving most of the data
while others are transmitting or receiving very little, this is a symptom of out-of-balance ports.

Steps

1. From the OnCommand Insight Open menu, select Assurance > Port Balance Violations.

2. Click the Balance Index column to change the sort order of the Hosts by the Balance Index
value.

3. Select a host with a high Balance Index compared to its threshold.

4. Click the Switch Port Performanceicon and select a line describing a switch that interests you.

5. Click the Performance Chart and Port Performance Distribution icons.

Review the detailed information see if a host is sending much more data through one switch than
another. If this is the case, one switch may be over-utilized, which could result in slower
applications, or if the switch carrying the data fails or is taken offline, the host will experience
severe performance degradation.
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Identifying resources for storage allocation

After you know how much data you have and where and how much bandwidth current individual
network paths (switches, ports) provide, you can decide how much data can be allocated to existing
devices and the path through which the data can flow. Then you know if new hardware is necessary,
and where on your network new hardware is most needed.

About this task

To identify resources for new storage allocation, follow these general steps:

Steps

1.

2
3
4,
5

Identify a storage array that meets the requirements including available space, bandwidth, and
tier.

Select storage ports based on performance and connection.
Identify volumes with potential capacity based on their array, speed, and availability.
Select switch ports based on the amount of available bandwidth.

Identify Tier 1 to Tier 2 storage migration candidates.

Analyzing storage port balance violations

When examining storage port balance violations, you need to determine if the violations indicate
legitimate problems or not.

Steps

1
2.
3.

To examine the list of storage port balance violations, select Assurance > Violations Browser.
In the browser tree, expand All Violations and select Storage Port Balance.
Select one violation of interest, right-click, and select the Analyze Violation option.

In the Port Balance Violations view, select the violation to display switch port performance data
and the performance charts.
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After you finish

If the device ports should be balanced but are not, change the device configuration to resolve the
issue. However, if the device port traffic is permitted to be out-of-balance, you can modify the policy
on the device to increase the balance index threshold or disable the policy on the device completely
to eliminate the violation.

Identifying an available storage array

As a first step in identifying resources for reallocating storage, you need to identify a storage array
that is a good capacity candidate.

Steps
1. From the OnCommand Insight Open menu, select Performance > Switch Port Performance.

2. To display all devices including storage devices, the amount of data traffic, and amount of data
traffic per storage device, select Connected Device Type then Name, Last Week and Traffic
from the menus.

3. If your storage array must be in a certain location or of a certain type, click the title bar of the
storage array to open the filter and type letters or words to display the appropriate arrays.

4. Select a storage array with a low distribution percentage.

A low distribution percentage indicates that the storage device has been used very little over the
past week and has neither received nor sent much data, making it a good resource candidate for
new storage allocation. The array could also be used to house data for an existing over-utilized

storage array.

Selecting storage ports
The second step in the resource allocation is to identify the storage port(s) that are good candidates

for your capacity needs.
Steps

1. After identifying the best storage array in the Switch Port Performance view, expand the storage
device to examine the list of ports.

2. Select storage ports with a low distribution percentage and low value.

A low value in both categories is optimal. This indicates that the storage port has been used very
little, making it a good candidate to mask volumes to the port.

Identifying volumes with potential capacity

After the best storage array and storage port are identified, select the best volume for your capacity
needs.

Steps

1. From the OnCommand Insight Open menu, select I nventory > Storage Arrays.

2. Select the storage array chosen earlier. You can sort or filter by name.

3. Click the Masking and Volumesicons.

4. Review all the available volumes on the selected storage array.

5

In the Masking view, expand the No Mapping and/or No Masking categories and select the
volume that meets your requirements for available space and capacity.
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The No Mapping and No Masking views display only those volumes for the selected storage
array that have not yet been mapped or masked, respectively, in the network.

Identifying Tier 1 to Tier 2 data migration candidates

To use your storage network as efficiently as possible, applications should be matched to devices that
deliver appropriate services. High-traffic applications using critical data need Tier 1 storage. Lower-
traffic applications can safely use lower-tier, cheaper storage devices.

About this task

Applications that have requested and are assigned Tier 1 status sometimes use only a fraction of Tier
1 performance and can be safely migrated to cheaper storage arrays, freeing expensive storage
capacity to make better use of existing storage devices and avoid the unnecessary purchase of
additional (and expensive) Tier 1 storage.

Steps
1. From the OnCommand Insight Open menu, select Performance > Switch Port Performance.

2. Select BU then Application then Connected Device and L ast Week from the menus.

This displays all business entities, the applications they use, and the devices those applications
reside on. This view shows the amount of data traffic in Megabytes that has traveled through each
device over the past week.

3. To sort the storage arrays experiencing the most data traffic in descending order, click the
Distribution column heading.

4. Expand a business entity and then the applications that are experiencing low levels of data traffic.

If the applications showing little data through their respective hosts reside on a Tier 1 storage
array, they can safely be migrated to a lower-tier array. In the current view, you can also expand
the Name column to show the individual hosts and to see the amount of data flowing to all its
ports.

5. To copy the name of a selected host, highlight the line for that host and double-click on the name
in the Connected Device Name column. Press Ctrl+C.

You can use this text in the filter to pinpoint the host in the next view.

6. From the OnCommand Insight Open menu, select Inventory > Storage Arrays.

If the storage arrays for that host are Tier 1 arrays, it is advantageous to move one or more
applications on the host to cheaper, lower-tier arrays.

Balancing data flow across storage array ports

If large amounts of data are flowing through a small number of storage array ports, the array cannot
operate efficiently. To maximize the performance of your storage arrays, ensure that the data is
distributed equally across all storage array ports.

About this task

Redirecting data traffic going to the ports on the array through one of the non-utilized (or in most
cases, under-utilized) storage ports will alleviate bottlenecks. Additionally, a large amount of non-
utilized ports makes this array a good candidate to house data for new applications or to house data
from other storage arrays that are experiencing very high amounts of data traffic.
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Steps

1.

From the OnCommand Insight Open menu, select Performance > Switch Port Performance.

Be certain that Connected Device Type then Name and the time period are selected in the drop-
down lists.

Expand the storage list in the first column. Select a storage array and expand it.

To sort storage array data distribution from high to low, click the Distribution column.

This displays the data traffic flow across the storage ports on the array in descending order.

Highlight one or more storage ports of interest and click the Port Performance Distribution
icon.

Identify any ports that are receiving the majority of the traffic while others are receiving very
little.

Balancing data flow across ISLs

Inter-Switch links (ISLs) connect high-speed switches. If large amounts of data are flowing through
only one ISL port while other ISL ports experience small amounts of data flow, the ISL is
imbalanced and operating inefficiently. To maximize the performance of your ISLs, ensure the data is
distributed equally across all ISL ports.

Steps

1

From the OnCommand Insight Open menu, select Performance > Switch Port Performance.

Be certain that Connected Device Typethen Name and Last Week are selected in the drop-
down lists.

To sort the data distribution from high to low, click the Distribution column.

This displays the data traffic flow across the switch ports in descending order.

Select an individual switch and expand it.

You can see the traffic moving between ISLs on the expanded switch. The switch under
Connected Device Name is the switch that is expanded in the far-left column. The second switch
is identified under the heading Switch.

Check to see if any links are carrying more data than other links.

It is very likely that this imbalance is the result of a misconfiguration or another problem and
should be corrected as soon as possible.

Allocating capacity to a new host

In order to implement the allocation of capacity to a new host, the administrator needs to look at the
array and select an array that best fits the request. Using filters, view all of the arrays that exist in the
data center (using business entities or annotations) and then select an array with the lowest disk
utilization.

Steps

1. Open Performance > Storage Performance.

2. Select one or more arrays that you believe might be under-utilized based on the Disk Utilization

percentages in the Storage Performance view.
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3. Click the Disk Performance detail view icon to show more information about the disk utilization
for the selected arrays.

In this example, the information is grouped by the Data Center annotation.
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4. If necessary, select different arrays in the Storage Performance view to analyze.

5. After you have selected the arrays that are the most under-utilized, right-click those array
descriptions in the Storage Performance view.

6. Select the Analyze option. The Disks tab is open in the Analyze dialog box.
7. Select a disk in the Disk Performance list that you want to investigate.

8. For the selected disk, click the Volume Perfor mance icon to display the All Volumeson
Selected Disk detail view. This view reveals the volumes that reside on the disk.

9. You might also want to display the Performance Chart for that volume, as shown in this
example.
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9 Mo selections in All volumes on Selected Disk

10. Inthe All Volumeson Selected Disk detail view, change the data grouping to Storage and select
the volume to use as the new target volume for the capacity requirement.

Allocating capacity to an existing host

Usually when a host is connected to an array, the storage administrator tries to allocate the next
volume for that host from the same array unless the array is hot (in other words, unless devices are
already in heavy use on a regular basis or at a critical threshold).

Before you begin

To perform the allocation, the administrator must first locate the arrays that are connected to the
required host.

Steps

1. Select Performance > Host Performance.

2. Select a grouping for the data. This example is grouped by Application Priority then Application.
3. Locate the host that needs to be allocated more capacity.

4. Click the Topology icon to determine which arrays are connected to the selected host.

5

To see all of the devices, click on an item in the topology and select the Add All Connected
Devices option.
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6. Select an array in the topology view and click the Disk Performance icon.
7. ldentify the disk with the lowest utilization in the Disk Performance detail view.

8. Right-click on that disk and select the Analyze option. The Disk Performance view shows only
data for the chosen disk.

9. Sort this data using the grouping data for Storage.

10. Select a volume from the list of volumes. That volume might be a good choice for the volume for
the capacity requirement.

When selecting a new volume to allocate on an existing host, the storage administrator can also
use the Topology view to see the storage that the host is already using.

Related references

Disk Performance view on page 67
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Performance reference

This reference material provides detailed descriptions of the main views and detail views for the
Perfor mance features.

This reference lists the items in alphabetical order.

Automatic storage tiering in Inventory and Performance
views

Data in views is affected by the use of automatic storage tiering.

If a host uses a volume that is configured for automated storage tiering (for example, FAST VP),
OnCommand Insight does not show all of the storage pools for the volume. You see only the primary,
native pool for that volume. If, as part of the automatic storage tiering, a volume moves to another
storage pool, Insight does not display the new relationship.

The following views are impacted by the use of automatic storage tiering (for example, FAST VP):

Analyze: The Disks tab does not show the full list of disks; it shows only the primary storage pool
disks. The Backend Volumes tab does not show the full list of backend volumes; it shows only the
backend volumes of the primary storage pool. The Volumes and Backend Volumes center views
of the Disks tab do not show all the relevant volumes. The Disks center view of the Volumes tab
does not show all the relevant disks. The Hosts tab does not show all the hosts using a disk. The
Daily Patterns tab does not show complete information when Disk or Backend Volume is
selected for Performance data.

Backend Volumes and Backend Volume Performance detail views: Do not show all the relevant
backend volumes.

Disks and Disk Performance detail views: Do not show all the relevant disks.

Disk metric columns of the Host Performance view: Because roll-up values do not include all the
relevant disks, these columns contain N/A values.

Host Performance Chart view and Host Performance Distribution view: No data is shown if
automatic storage tiering would display incorrect data.

Storage Pools and Storage Pool Performance detail views: Do not show all the relevant storage
pools.

Virtual Storage detail view: Does not show all the relevant virtual disks and backend volumes.

Volume Members By Disk dialog box: Does not show all the relevant volume members.

Related references

Analyze dialog box on page 47
Disk Performance view on page 67
Performance Distribution view on page 79

Analyze dialog box

The Analyze dialog box displays summaries of potential performance problems including error
messages and lists of associated resources. You can use it to identify potential problems by isolating
the location of contention and the source of delays and by comparing performance data for different



48 | OnCommand Insight Performance Guide

time periods to note changes. The Summary tab is the dashboard for research into a selected
performance problem with links to more information.

Navigation

» Select one of the performance-related items in the search results.

» Select an item related to performance in a view, right-click, and selectAnalyze.

« Toreturn to a previous view of the dialog box, click the left Back arrow in the upper left corner of
the dialog box.
To move forward in the tab views, click the smaller right arrow.

» To display a breadcrumb list of the previously displayed views, click and hold the arrow with the
blue background (active).

Tabs

Select any of these tabs to display additional information about the selected items in the view. You
might also want to select items on these tabs and display detail views that contain even more specific
information.

The tabs displayed in the dialog box depend on the type of item you selected. The following tabs are
available:

* <resource type> Summary
» Disks

*  Volumes

» Contending Volumes

* Internal Volumes

+ Backend Volumes

* Nodes

» Switch Ports

e Contending Switch Ports

» Storage Pools

* SAN path Violations

* Hosts

» Datastores

» Virtual Machines

« Contending Virtual Machines
* VMDKs

» Daily Patterns

e Topology

The performance data might include information about contention. This information is displayed on
specifically identified tabs, such as the Contending Volumes version of the Volumes tab.
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If you analyze performance on a storage virtualizer, the Volumes and Internal Volumes tabs show the
performance of the virtual volumes and internal volumes created by the virtualizer. The Disks tab
shows the performance of the virtual disks used by the virtualizer. The Backend Volumes tab shows
the performance of all the backend volumes used by the virtualizer.

Related concepts

Performance trend analysis on page 13
Automatic storage tiering in Inventory and Performance views on page 47

Related tasks

Searching for performance data on page 11

Monitoring data store performance on page 17

Troubleshooting slow client computers on your network on page 32
Allocating capacity to a new hoston page 43

Related references

Host Summary tab on page 52

Daily Performance Pattern histogram

The Daily Patterns tab displays a histogram showing performance data for the selected disk, volume,
end volume, internal volume, or backend volume as a percentage utilization rate. You can change the
time period for the performance data sample and refresh the histogram.

Navigation

From the OnCommand Insight Open menu, select Performance and any of the performance views.
Right-click on a device in the performance view and select the Analyze option. Click the Daily
Patternstab to display the performance histogram.

Descriptions

Performance Data
You select from these options:

« Disk

e Internal Volume
e \Volume

» Backend Volume

Metric

You select from the utilization, IOPS, Throughput, and Accessed options in the pull-down
menu.

Data Store Summary tab

The Data Store Summary tab on the Analyze dialog box provides performance troubleshooting data,
enabling you to see the basic information for the element and the resources it is using, together with
links to additional information for the storage resources.

Troubleshooting information

The left side of this summary lists:
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» Name of the data store
» Capacity
* VMDAKSs capacity
» Cluster Hosts:
o CPU average utilization
o Memory utilization
* Cluster FC Network:
o Port utilization
o Porterrors
» Storage resource used by the data store
o Links to individual storage resources for more information
o Capacity of the storage resource
o Response Time
> |OPS
o Throughput
Numbers shown in red on the Data Store Summary tab indicate values that are beyond the policy

threshold.

Network information

The right side of this summary lists:
* Virtual Center IP address with a link to more information

e Data sources

Possible error messages

Two error messages might display on this tab:
« Data is not being collected indicates that the data sources have stopped collecting data.

 Data last collected (tine) indicates that the displayed data is out-of-date.

Related tasks

Monitoring data store performance on page 17

Disks tab

You use the Disks tab in the Analyze dialog box to see all of the arrays and the corresponding disks
that the hosts are using. You can identify any hosts that are competing for array resources. This
information helps you understand potential contention issues that might arise. You can change the
analysis period and refresh the data.

Navigation

» To display the Disks tab in the Analyze dialog box, right-click one or more items in any of these
views:
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o Storage Arrays

o Application Performance
o Switch Port Performance
o Storage Performance

» Select Analyze.

Column descriptions

blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name
Name of the disk in the array.
Storage
Name of the storage array.
icon (Isvirtual?)
A "V" icon indicates that the device is a virtualized volume.
Hosts
Name of the hosts using the disk.
Disk Size (GB)
The physical disk capacity, in gigabytes. This differs from usable capacity when

technologies such as RAID are used, where some of the raw capacity is used for
protection purposes.

Disk Group

Name of the set of disks that share a common configuration. A disk group contains
volumes that must use disks within that disk group.

Disk Speed (RPM)
How fast the disk spins, in RPM. (This value is not applicable to SSD disks.)
Utilization

The portion of the total percentage of pre-cache Service Time used for Read and Write
requests out of the selected time range.

Utilization (R& W)

The percentage of pre-cache Service Time used for Read or Write requests out of the
selected time range.

Position
Where the disk is located (for example, as in Symmetrix: DirectorID-075, Slot 38).
Role

Role of the disk, as obtained from the vendor. Values include data, faulty, parity, double
parity, mixed, spare, unallocated, or other. For spare disks, "spare" is displayed.

Status

Status of the disk. The following values could appear: Normal, copying, Failed, Partner,
Pending, Questionable, Reconstructing, Zeroing, Other.

M odel
Name of disk model.

Vendor



52 | OnCommand Insight Performance Guide

Name of disk vendor.

Type
Type of disk. One of the following values appears: ATA, FATA, FC, SAS, SATA, SATA?2,
SATAS3, SSD, Other.

Serial Number
Serial number of the disk, if the data source supports reporting it.
Top Utilization

The maximum percentage of the total pre-cache Service Time that can be used for
requests out of the selected time range.

IOPS

The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/0 per sec).

|OPS (R& W)

The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

Top IOPS

The maximum number of 1/O service requests that can pass through the 1/0 channel or
portion of that channel per unit of time (measured in 1/O per sec).

Throughput

Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Throughput (R& W)

Rate at which Read or Write data is being received in a fixed amount of time in response
to 1/O service requests (measured in MB per sec).

Top Throughput

Maximum rate at which data can be received in a fixed amount of time in response to 1/O
service requests (measured in MB per sec).

Accessed

“Yes” indicates that the resource was accessed in the selected time range.
Application

Name of application.
Application Priority

Importance of this application as defined when establishing the business entities.

Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Host Summary tab

The Host Summary tab on the Analyze dialog box provides performance troubleshooting data for the
hosts, enables you to see the basic information for the element and the resources it is using, and links
to additional information for the storage resources.

Troubleshooting information

The left side of this summary lists:
* Name of the host

* |P addresses
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e Storage Resources:
o Total capacity
o Links to individual storage resources for more information
o Capacity of the storage resource
o Response time
> 10OPS
o Throughput
e FC ports used by the cluster network:
o Balance index
o Name of the FC port
o Utilization of the FC port
o Transfer Rate
o Connected to
o Errors
* Recent Violation Events

Numbers shown in red on the Host Summary tab indicate values that are beyond the policy threshold.

Location and application information

The right side of this summary lists:

» Data Center name

» Applications running on the host

» Business Entities supported on the host

* Auto Resolution indicator

Possible error messages

Two error messages might display on this tab:
« Data is not being coll ected indicates that the data sources have stopped collecting data.

 Data last collected (tine) indicates that the displayed data is out-of-date.

Related tasks

Searching for performance data on page 11

Troubleshooting slow client computers on your network on page 32
Troubleshooting poor application performance on page 33
Analyzing port balance violations on page 38

Related references

Host Performance view on page 70
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Internal Volume Summary tab

The Internal Volume Summary tab on the Analyze dialog box provides performance troubleshooting
data, enables you to see the basic information for the element and the resources it is using, and links
to additional information for the internal volumes.

Troubleshooting information

The left side of this summary lists:
* Name of the internal volume
» Name of the storage on which the storage pool resides
e Used capacity
» Snapshot capacity
» Deduplication
« Top response time
e Top IOPS
» Top Throughput
» Storage Pools used by the internal volume:
o Link to information about a storage pool
o Response Time of the storage pool
o |0OPS
o Throughput
Numbers shown in red on the Internal Volume Summary tab indicate values that are beyond the

performance policy threshold.

Internal volume and application information

The right side of this summary lists:

* Type of volume

» Network technology

*  Number of shares

* Clone source link

o Tier

» Applications running on the internal volume

» Business Entities supported on the internal volume

e Data sources

Possible error messages

Two error messages might display on this tab:

« Data is not being coll ected indicates that the data sources have stopped collecting data.
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Data | ast collected (tine) indicates that the displayed data is out-of-date.

Storage Pool Summary tab

The Storage Pool Summary tab on the Analyze dialog box provides performance troubleshooting
data, enables you to see the basic information for the element and the resources it is using, and links
to additional information for the storage pools.

Troubleshooting information

The left side of this summary lists:

Name of the storage pool
Storage pool vendor description
Used capacity

Top Response Time

Top IOPS

Top Throughput

Resources provisioned for the storage pool with the number of resources and the Provisioned
capacity (GB of total and percentage):

o Link information about a resource
o Response Time for the resource

> 10PS of the resource

o Throughput of the resource

Disks used by the storage pool:

o Disk size
o Disk type
o Disk speed

o Average utilization

List of the individual disks:
o Name of the disk

o Utilization of the disk

o |0PS

o Throughput

Numbers shown in red on the Storage Pool Summary tab indicate values that are beyond the
performance policy threshold.

Storage Pool information

The right side of this summary lists:

Type of storage pool
Redundancy
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e Tier
e Data center

e Data sources

Possible error messages

Two error messages might display on this tab:
e Data is not being coll ected indicates that the data sources have stopped collecting data.

e Data last collected (tine) indicates that the displayed data is out-of-date.

Virtual Machine Summary tab

The Virtual Machine Summary tab on the Analyze dialog box provides performance troubleshooting
data, enables you to see the basic information for the element and the resources it is using, and links
to additional information for the virtual machines.

Troubleshooting information

The left side of this summary lists:
» Name of the virtual machine
« CPU Utilization
* Memory utilization
* Hypervisor:
o Link to information about the Hypervisor
o Hypervisor CPU Count
o CPU Utilization
o Memory Utilization
> VM Count
* VMDKs:
o Total VMDK Capacity
o Name of the VMDK
o Capacity
o Used Capacity
o Latency
o Link to the VMDK storage resource
» Datastores used by the virtual machine:
o Link to the data store by Name
o Capacity of each data store

Numbers shown in red on the Virtual Machine Summary tab indicate values that are beyond the
performance policy threshold.
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Network and application information

The right side of this summary lists:
» Applications running on the virtual machine
» Business Entities supported on the virtual machine

« Data sources

Possible error messages

Two error messages might display on this tab:
« Data is not being coll ected indicates that the data sources have stopped collecting data.

e Data last collected (tine) indicates that the displayed data is out-of-date.

Related tasks

Determining if a VM is affecting host performance on page 30

Volume Summary tab

The Volume Summary tab on the Analyze dialog box provides performance troubleshooting data,
enables you to see the basic information for the element and the resources it is using, and links to
additional information for the volumes.

Troubleshooting information

The left side of this summary lists:
* Name of the volume
« Storage type
e Capacity
» Top Response Time
e Top IOPS
e Top Throughput
» Clients using the volume:
o Link to client information
o Response Time for the client
o |OPS of clients
o Throughput of the client
e FC storage ports mapped to the volume:
o Name of the port
o Utilization
o Transfer Rate of the port
o Connected to

o Errors
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* Internal Volume used by the volume:
o Link to information about an internal volume
o Response Time of the internal volume
> I0OPS
o Throughput
» Storage Pools used by the volume:
o Link to information about a storage pool
o Response Time of the storage pool
o |0OPS
o Throughput
Numbers shown in red on the Volume Summary tab indicate values that are beyond the performance

policy threshold.

Volume and application information

The right side of this summary lists:

» Type of volume

o Tier

» Applications running on the volume

» Business Entities supported on the volume

e Data sources

Possible error messages
Two error messages might display on this tab:
e Data is not being coll ected indicates that the data sources have stopped collecting data.

 Data last collected (tine) indicates that the displayed data is out-of-date.

Related tasks

Troubleshooting poor application performance on page 33
Searching for performance data on page 11

Application Performance view

In the Application Performance view, you can display performance data for applications to determine
whether one application has affected the performance of another application. You might display
information in this view by the business entities you have defined and associated with applications.

Navigation

From the Open menu, select Performance > Application Performance.



Performance reference | 59

Column descriptions

blank
Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.
Application
Name of application.
Application Priority
Importance of this application as defined when establishing the business entities.
Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Volume Response Time
The time it takes from the moment a request for information arrives at the storage device
to the time when the storage device begins to send the information back in response.
Volume Response Time (R& W)

The time it takes from the moment a request for information arrives at the storage device
to the time when the storage device begins to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.

Top Volume Response Time

The longest time it takes from the moment a request for information arrives at the storage
device until the time when the storage device begins to send the information back in
response.

Volume |OPS
The number of Read or Write 1/O service requests.

Volume |OPS (R& W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Top Volume IOPS
The maximum number of Read or Write 1/O service requests.

Volume Throughput
Rate at which data was transferred to/from the volume in response to 1/O service requests
during the time period of the selected item.

Volume Throughput (R& W)
Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Top Volume Throughput
The maximum rate that data can be transmitted.

Volume Cache Hit Ratio (R& W)

Percentage of Read/Write requests that result in cache hits. The higher the number of hits
versus accesses to the volume, the better the performance. This column is empty for
storage arrays that do not collect cache hit information.

Volume Partial (R& W)

Total number of times that a read or write crosses a stripe boundary on the volume.
Generally, stripe crossings are not beneficial, because each one requires an additional 1/0.
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A low percentage indicates an efficient stripe element size. Indication of improper
alignment of a volume (or a NetApp LUN).

Write Pending
The number of Write 1/O service requests that are pending.

Volume Accessed
“Yes” indicates that the resource was accessed in the selected time range.

Internal Volume Response Time

The time it takes from the moment a request for information arrives at the storage device
to the time when the storage device begins to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible. The
OnCommand Insight response time value is measured in milliseconds from within the
storage array.

Internal Volume Response Time (R& W)

The time it takes from the moment a request for information arrives at the storage device
to the time when the storage device begins to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.

Top Internal Volume Response Time

The maximum time it takes from the moment a request for information arrives at the
storage device until the time when the storage device begins to send the information back
in response.

Internal Volume lOPS

The total number of Read/Write 1/0 service requests passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/O per sec).

Internal Volume | OPS (R& W)

The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

Top Internal Volume | OPS
The maximum number of Read or Write 1/O service requests.
Internal Volume Throughput (R& W)

Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Top Internal Volume Throughput
The maximum rate that data can be transmitted in a fixed amount of time.

Internal Volume Accessed
“Yes” indicates that the resource was accessed in the selected time range.

Options

From the Application Performance view, right-click to show a pop-up menu containing the following
options.

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance.

Analyze Stor age Pools
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Available only with the Assure license. Allows you to select a specific storage pool and
assess its status related to the thin-provisioning policies. You can use this dialog box,
instead of the Violations Browser, to see the current thin provisioning violations and how
close the storage pool is to reaching the policy limits.

Backend Volume Performance view

Using the Backend Volume Performance view, you can see all the volumes residing on the backend
storage arrays connected to the selected virtualizer instead of the virtual volumes. This data helps you
better use capacity and assists in proactive analysis of how the storage resources are being used. You
can display information in this view by the business entities you have defined and associated with
applications.

Navigation

From the OnCommand Insight Open menu, select Performance > Application Performance. Click
the Backend Volume Performance icon.

Column descriptions

blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Volume
Name of volume.
L abel
An alternate name or alias assigned to a volume by the storage administrator.

uuIiD
Universally unique identifier for the object. In this case, it is generated by and retrieved
from the storage array itself.

Storage
Name of the storage array.

Storage Pool
The name of the storage pool on which the backend volume resides.
Auto Tiering

A checkmark indicates that the selected storage pool is using the automatic storage tiering
technology (for example, FAST VP).

Thin Provisioned
A checkmark indicates that the volume is leveraging thin provisioning.
vFiler

The name of the vFiler unit. A vFiler unit is an isolated software container that behaves
exactly like a physical storage array. A vFiler unit shares the physical resources of the
array, but abstracts the client access from the physical array into virtual arrays.

Internal Volume
Name of the internal volume that the volume uses.

Qtree
Name of the gtree on this volume.

icon (array virtualization type)
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Indicates type of virtualization. Showing on a virtual volume, a "V" icon indicates that the
device is a virtualized volume and a "B" icon indicates that the device is a backend
volume.

Virtualizer
For backend volumes in array virtualization. Displays the name of the front end virtualizer
that is using this volume.

Virtual Storage Pool
For backend volumes in array virtualization. The name of the storage pool on the front end
virtualizer that is using this volume.

Datastore
The name of data store residing on this volume.

Application
Application associated with this volume.

Application Priority
The importance of this application within your organization that was set when defining the
application.

Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Hosts
Hosts making use of the volume.

Capacity (GB)
Size of the volume that is accessible to host applications, in gigabytes.

Raw Capacity (GB)
Physical disk capacity of the volume, in gigabytes. This differs from usable capacity when
technologies such as RAID-5 are used, where some of the raw capacity is used for
protection purposes.

Consumed Capacity (GB)

The amount of capacity that the volume consumes from underlying storage (for example,
internal volume and storage pool). For non-thin provisioned value, that is the same as the
volume's capacity. For thin provisioned volumes, it is the amount of capacity used to store
the volume's contents. Its value is also affected by Snapshot copies, deduplication, and
other storage technologies. If the volume does not have usage information available, this
appears blank.

Mapped Ports

The number of storage ports through which this volume is accessible.

Redundancy
Level of mirroring defined for the device based on the storage technology, for example,
RAID-DP, underlying the device. This is taken from the device itself. For an explanation
of values, see the device documentation.
Response Time
The time it takes from the moment a request for information arrives at the storage device
to the time when the storage devices begin to send the information back in response.
Response Time (R& W)
The time it takes for a read or write request to arrive at the storage device and to respond
to the request.

Top Response Time
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The maximum length of time in milliseconds that it takes from the moment a request for
information arrives at the storage device to the time when the storage devices begin to
send the information back in response.

IOPS
The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/O per sec).

IOPS (R&W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

Top IOPS
The maximum number of 1/O service requests that can pass through the 1/0 channel or
portion of that channel per unit of time (measured in 1/O per sec).

Throughput
Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Throughput (R& W)
Rate at which Read or Write data is being received in a fixed amount of time in response
to 1/O service requests (measured in MB per sec).

Top Throughput
Maximum rate at which data can be received in a fixed amount of time in response to 1/O
service requests (measured in MB per sec).

Cache Hit Ratio
Percentage of requests that result in cache hits. The higher the number of hits versus
accesses to the volume, the better the performance. This column is empty for storage
arrays that do not collect cache hit information.

CacheHit Ratio (R& W)
Percentage of Read/Write requests that result in cache hits. The higher the number of hits
versus accesses to the volume, the better the performance. This column is empty for
storage arrays that do not collect cache hit information.

Partial (R& W)

Total number of times that a read or write crosses a stripe boundary on any disk module in
RAID 5, RAID 1/0 or RAID 0 LUN. Generally, stripe crossings are not beneficial,
because each one requires an additional 1/0. A low percentage indicates an efficient stripe
element size and is an indication of improper alignment of a volume (or a NetApp LUN).
For CLARIiON only, this value is the number of stripe crossings divided by the total
number of IOPS.

Write Pending

The number of Write 1/O service requests that are pending.

Accessed
"Yes" indicates that the resource was accessed in the selected time range.

annotations
Annotations associated with each volume.
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Datastore Performance view

This view correlates data store performance with storage and switch port performance. The data store
performance metrics are aggregates of the VMDK performance. You can see the sum of IOPS and
throughput, the maximum latency values, and the average Hypervisor CPU and memory utilization.

Navigation

From the Open menu, select Performance > Datastor e Perfor mance.

Column descriptions

blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name
The data store name that represents the virtual machines.
Virtual Center IP
The IP address of the Virtual Center Host for the data store.
VM Count
The number of virtual machines whose files are contained in this data store.
Hypervisor Count
The number of Hypervisor hosts that use this data store for their virtual machines.

FC Ports

The number of fibre channel ports in the physical storage paths that this data store
logically represents.

Capacity (GB)
Usable capacity or configured size of the data store, in gigabytes.
Provisioned Capacity (GB)

The amount of total capacity that has been set aside for potential use, based on the virtual
machines using this data store. Includes space set aside for virtual machine files of all

types.
Used Capacity (GB)

The amount of capacity holding actual data in the data store. Includes usage based on all
file types.

Unused Capacity (GB)

The available capacity of the data store, in gigabytes.
VM DK s Capacity (GB)

The virtual machine usable capacity, in gigabytes.

Over-committed Capacity (GB)

The amount of capacity that has been overcommitted from this resource. When thin
provisioning is in use, the total size can exceed the total size of the capacity committed. If
there is no over commitment on the data store, the value is 0.

Commit Ratio
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The ratio of the sum of the capacity of all virtual disks allocated on a data store to the
capacity of the data store. If thin provisioning is in place, the rate can be greater than
100% meaning it is over committed.

HasFC Port Errors
Indicates if there were any port errors over the given time span.

FC Port Utilization
The average utilization percent for the FC ports belonging to the data store's physical
paths over the given time span.

Storage
Storage arrays used by this data store.

Resource Name
The volumes or internal volumes in the path.
Resour ce Capacity (GB)
The total capacity, in gigabytes, of the volumes or internal volumes in this data store's
paths.
Resource Used Capacity (GB)
The total used capacity, in gigabytes, of the volumes or internal volumes in this data
store's paths.
Resour ce Technology
The SAN (FC and iSCSI) or NAS (NFS and CIFS) protocols that the device supports.
Deduplication Savings
The known amount of storage savings through deduplication, a process that detects blocks
with identical content and replaces subsequent identical blocks with a reference to a single
copy of the block.
Storage Pools
Storage pools used by this data store.

HV Memory Utilization

The average memory utilization percent of this data store's Hypervisors for the given time
span.

HV CPU Utilization

The average memory utilization percent of this data store's Hypervisors for the given time
span.

VMDK |0PS (R&W)

The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

VMDK I10PS

The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/0 per sec).

VMDK Top IOPS
The maximum number of the IOPS reported by the measured devices in the time period.
VMDK Throughput (R& W)

Rate at which Read or Write data is being received in a fixed amount of time in response
to 1/0 service requests (measured in MB per sec).

VMDK Throughput

Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).
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VMDK Top Throughput
The maximum number of throughput reported by the measured devices in the time period.
VMDK Latency (R&W)
The response time for a Read or Write from the virtual machines.
VMDK Latency
The average response time from the virtual machines carved from a data store.
VMDK Top Latency
The maximum response time from the virtual machines carved from a data store in the
time period.
Storage |OPS
The average IOPS of the data store's storages for the given time span.

Storage |OPS (R& W)
The average read or write IOPS for the data store.

Top Storage | OPS
The maximum observed IOPS (peak) for all data stores within the hour.

Storage Response Time
The average response time of the data store's storage for the given time span. This is the
time it takes from the moment a request for information is sent until the information starts
arriving.

Storage Response Time (R& W)
The maximum read or write response time for this data store throughout the hour.

Top Storage Response Time
The maximum observed response time for this data store within the hour.

Partial R/W

Total number of times that a read or write crosses a stripe boundary on any disk module in
RAID 5, RAID 1/0 or RAID 0 LUN. Generally, stripe crossings are not beneficial,
because each one requires an additional 1/0O. A low percentage indicates an efficient stripe
element size and is an indication of improper alignment of a volume (or a NetApp LUN).
For CLARIiON only, this value is the number of stripe crossings divided by the total
number of IOPS.

Storage Throughput

The average throughput of the data store's storage for the given time span.
Storage Throughput (R& W)
The average read or write throughput for the given time.

Top Storage Throughput
The maximum observed (peak) throughput for the data store's storage for a given time.

Options
The following options are available from the right-click menu:

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance. The Data Store Summary tab provides
information that might be needed for troubleshooting.

Analyze Storage Pools
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Available only with the Assure license. Allows you to select a specific storage pool and
assess its status related to the thin provisioning policies. You can use this dialog box,
instead of the Violations Browser, to see the current thin provisioning violations and how
close the storage pool is to reaching the policy limits.

Modify Policy

Changes the policy that governs alerts set on this resource. This option requires the Assure
license.

Related tasks

Monitoring data store performance on page 17

Disk Performance view

You use the Disk Performance view to see all the arrays and corresponding disks that the hosts are
using and metrics that can help you analyze performance. You can identify any hosts that are
competing for array resources. This view can be vital because it helps you see potential contention
issues before they arise.

Navigation

From the OnCommand Insight Open menu, select Performance > Host Perfor mance or Datastore
Performance. Click the Disk Performanceicon.

Column descriptions

blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name
Name of the disk in the array.
Storage
Name of the storage array.
icon (Isvirtual?)
A "V" icon in this column indicates that the device is a virtualized volume.
Hosts
Name of the hosts using the disk.
Disk Size (GB)
The physical disk capacity, in gigabytes. This differs from usable capacity when

technologies such as RAID are used, where some of the raw capacity is used for
protection purposes.

Disk Group

Name of the set of disks that share a common configuration. A disk group contains
volumes that must use disks within that disk group.

Disk Speed (RPM)

How fast the disk spins, in revolutions per minute. (This value is not applicable to SSD
disks.)

Utilization

The portion of the total percentage of pre-cache Service Time used for Read and Write
requests out of the selected time range.
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Utilization (R& W)
The percentage of pre-cache Service Time used for Read or Write requests out of the
selected time range.
Position
Where the disk is located (for example, as in Symmetrix: DirectorID-075, Slot 38).
Role
Role of the disk, as obtained from the vendor. Values include data, faulty, parity, double
parity, mixed, spare, unallocated, or other. For spare disks, "spare" appears.
Status
Status of the disk. The following values could appear: Normal, Copying, Failed, Partner,
Pending, Questionable, Reconstructing, Zeroing, Other.
Vendor
Name of disk vendor.
Type
Type of disk. One of the following values appears: ATA, FATA, FC, SAS, SATA, SATA?2,
SATA3, SSD, Other.
M odel
Name of disk model.

Serial Number
Serial number of the disk, if the data source supports reporting it.

Top Utilization
The maximum percentage of the total pre-cache Service Time that can be used for Read
and Write requests out of the selected time range.

IOPS
The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/O per sec).

|OPS (R& W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

Top 1OPS
The maximum number of 1/O service requests that can pass through the 1/0 channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Throughput
Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Throughput (R& W)
Rate at which Read or Write data is being received in a fixed amount of time in response
to 1/O service requests (measured in MB per sec).

Top Throughput
Maximum rate at which data can be received in a fixed amount of time in response to I/O
service requests (measured in MB per sec).

Accessed
"Yes" indicates that the resource was accessed in the selected time range.

Application
Name of application.
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Application Priority

Importance of this application as defined when establishing the business entities.
Tenant, Line of Business, Business Unit, Project

Columns listing the business entity components associated with the applications.

Options
The following options are available from the right-click menu:

Show Storage Pools
The Storage Pools by Disk dialog box lists the capacity information, disk size, disk group,
and disk speed for each disk.

Analyze
Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance.

Analyze Storage Pools

Available only with the Assure license. Allows you to select a specific storage pool and
assess its status related to the thin provisioning policies. You can use this dialog box
instead of the Violations Browser to see the current thin provisioning violations and how
close the storage pool is to reaching the policy limits.

Related concepts

Automatic storage tiering in Inventory and Performance views on page 47

Related tasks

Allocating capacity to a new host on page 43
Allocating capacity to an existing host on page 45

Histogram view

The OnCommand Insight histograms use a bar chart to show the relative amount of time the selected
ports spent in the given utilization levels. For the daily traffic, the histogram identifies when there are
traffic pattern spikes or troughs during a single day and identifies the average hourly values for the
analysis period. The performance histogram shows the percentage of available bandwidth used for
transmitted (Tx) and received (Rx) data. The Analyze dialog box supplies a specialized histogram
with multiple data type selections.

Navigation

e From the OnCommand Insight Open menu, select Performance > Switch Port Performance.
Right-click on a device in the performance view and select either the Show Daily Traffic Pattern
or Show Performance Histogram option.

» Open the Analyze dialog box and click the Daily Patternstab to display the Daily Performance
Pattern histogram. This histogram supplies selections for performance data and metrics to focus
the data displayed in the bar chart.

Descriptions

You can sort and filter the data in the histograms as in other OnCommand Insight views.
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The histogram for the Switch Port Performance data includes Fabric, Switch, and Switch Port
columns, always reflecting a port on a switch. The Device Type, Device Name, and Device Port show
the information about the port on the other end of the path. You can select a Fixed or Variable scale
for the display. The Fixed selection always begins with zero percent. The Variable selection allows
you to slide an indicator to begin the data with a higher percentage.

You can select multiple ports and see the collective impact of traffic on the switch or check individual
ports for periods of high or low traffic. The first column of the table allows the selection of individual
ports. The histogram displays all of the visible, selected rows in the table. Selections in the table at
the top control what is displayed in the chart below.

The Daily Performance Pattern histogram displayed from the Analyze dialog box allows you to select
different time periods available for the dialog box, performance metrics, and these performance data

options:
« Disk
* \olume

Internal Volume

Backend Volume

Host Performance view

Use this view to identify multipath validation and host balancing. The performance values aggregate
performance statistics for each host. The Internal Volume metric columns show the aggregate
performance measurements of all internal volumes that the host accesses. The Volume metric
columns show the aggregate performance measurements of all volumes the host accesses.

Navigation

From the Open menu, select Performance > Host Perfor mance.

Column descriptions

blank
Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

registered icon
Icon indicating that the host referenced by the policy is registered to the current user. To
view only those policies for your registered hosts, filter by this icon.

Name
Name of host on the network.

icon (Arethereviolations?)

Icon that indicates a policy violation.
Application

Names of the applications associated with the host.
Application Priority

The importance of this application within your organization, as set when defining the
application.

Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

V-Cluster
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Name of a cluster of virtualization hosts that share access to the same SAN volumes or
NAS share. For a standalone host, this is blank.

CPU Utilization

Amount of actively used CPU, as a percentage of total available (over all virtual CPUs).
Memory Utilization

Threshold for the memory used by the host.
Disk IOPS (R)

Total number of read I/O service requests to the disk passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/O per sec).

Disk Latency (R)

The sum of Disk Read Latency for the sampling period. Average amount of time taken
during the interval to process SCSI read commands issued from the Guest OS to the
virtual machine.

Disk Throughput (R)

Portion of data that the disk read in response to 1/O service requests to the disk (measured
in MB per sec).

Disk IOPS

The sum of Disk Read I0OPS and Disk Write IOPS.
Top Disk IOPS

The maximum (over all disks) for total IOPS.
Disk Latency

The sum of Disk Read Latency and Disk Write Latency for the sampling period.
Top Disk Latency

The maximum disk latency that the disk discovered for the sampling period.
Disk Throughput

Portion of data that the disk sent/received in response to 1/0 service requests to the disk
(measured in megabytes per sec).

Top Disk Throughput

The maximum amount of data that the disk can transmit in a fixed amount of time in
response to 1/0 service requests to the disk (measured in megabytes per sec).

Disk |OPS (W)

Total number of write 1/0 service requests to the disk passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/O per sec).

Disk Latency (W)

The sum of Disk Write Latency for the sampling period. Average amount of time taken
during the interval to process SCSI write commands issued from the Guest OS to the
virtual machine.

Disk Throughput (W)

Portion of data that the disk writes in response to 1/O service requests to the disk
(measured in megabytes per sec).

| P Throughput (Receive)
Average rate at which disk IP data was received in megabytes.

IP Throughput
Aggregate rate at which disk IP data was transmitted and received in megabytes.

I P Throughput (Transmit)
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Average rate at which disk IP data was transmitted in megabytes.

Disk Accessed
Indication if at least one disk was accessed (for read or write).

I P Accessed
Indication if Guest OS received or transmitted any IP data.

FC Balance I ndex

The standard deviation from the traffic average for all of the Fibre Channel ports; a high
value (above 50) signifies a ratio problem between the host ports, meaning that some ports
are experiencing a large amount of traffic and others very low, indicating a potential
problem.

Volume Response Time (R& W)
The time in milliseconds that it takes from the moment a request for information arrives at
the storage device to the time when the storage devices begin to send the information back
in response. This is the actual latency of the device, based on live samplings whenever
possible. OnCommand Insight measures response times from within the storage array.

Top Volume Response Time
The maximum amount of time it can take from the moment a request for information
arrives at the storage device until the time when the storage devices begin to send the
information back in response.

Volume |OPS (R& W)
Measures the total number of Read/Write 1/O service requests passing through the 1/0
channel or portion of that channel per unit of time (measured in 1/O per sec).

Top Volume lOPS
The maximum number of Read or Write 1/O service requests.

Volume Throughput (R& W)
Amount of Read or Write data that is being received in a fixed amount of time in response
to 1/O service requests (measured in megabytes per sec).

Top Volume Throughput
The maximum rate that data can be transmitted.

Volume Cache Hit Ratio (R& W)
Percentage of Read/Write requests that result in cache hits. The higher the number of hits
versus accesses to the volume, the better the performance.

Volume Partial R'W

Total number of times that a read or write crosses a stripe boundary on the volume.
Generally, stripe crossings are not beneficial, because each one requires an additional 1/0.
A low percentage indicates an efficient stripe element size, while a high percentage
indicates improper alignment of a volume (or a NetApp LUN).

Write Pending
The number of Write /O service requests that are pending.

Volume Accessed
“Yes” indicates that the resource was accessed in the selected time range.

Internal Volume Response Time (R& W)

The time it takes from the moment a request for information arrives at the storage device
to the time when the storage devices begin to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.
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Top Internal Volume Response Time

The maximum time it takes from the moment a request for information arrives at the
storage device until the time when the storage devices begin to send the information back
in response.

Internal Volume lOPS (R& W)

The total number of Read/Write 1/0O service requests passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Top Internal Volume lOPS
The maximum number of Read or Write 1/O service requests.
Internal Volume Throughput (R& W)

Amount of Read or Write data that is being received in a fixed amount of time in response
to 1/O service requests (measured in megabytes per sec).

Top Internal Volume Throughput

The maximum rate that data can be transmitted in a fixed amount of time.
Internal Volume Accessed

“Yes” indicates that the resource was accessed in the selected time range.
annotations

User-defined terminology associated with the devices.

Options
The following options are available from the right-click menu:

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance. The Host Summary tab provides
information that might be needed for troubleshooting.

Analyze Stor age Pools

Available only with the Assure license. Allows you to select a specific storage pool and
assess its status related to the thin provisioning policies. You can use this dialog box,
instead of the Violations Browser, to see the current thin provisioning violations and how
close the storage pool is to reaching the policy limits.

Modify Policy

Changes the policy that governs alerts set on this resource. This option requires the Assure
license.

Related tasks

Allocating capacity to an existing host on page 45
Troubleshooting slow client computers on your network on page 32
Troubleshooting poor application performarnce on page 33

Related references

Host Summary tab on page 52
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Internal Volume Performance view

You can view the internal volume relevant to the object selected and determine the internal volumes
that are competing for storage resources. Performance values reflect an aggregation of the load on all
of its shares and volumes residing on the internal volume.

Navigation

From the OnCommand Insight Open menu, select Performance > Host Performance. Click the
Internal Volume Performanceicon.

Column descriptions
blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name
Name of internal volume.

Storage
Name of storage array on which the internal volume resides.

vFiler
The name of the vFiler unit. A vFiler unit is an isolated software container that behaves
exactly like a physical storage array. A vFiler unit shares the physical resources of the
array, but abstracts the client access from the physical array into virtual arrays.
Application
Applications associated with the internal volume.
Application Priority
The importance of this application within your organization that was set when defining the
application.
Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.
Hosts
Hosts associated with the internal volume.
Capacity (GB)
Usable capacity of the internal volume, in gigabytes.
Raw Capacity (GB)

The physical disk capacity of the internal volume, in gigabytes. This differs from usable
capacity when technologies such as RAID are used, where some of the raw capacity is
used for protection purposes.

Used Capacity (GB)
The amount of capacity holding actual data in the internal volume. Includes usage based
on all file types.

Consumed Capacity (GB)

The amount of capacity that the volume consumes from underlying storage (for example,
internal volume and storage pool). For non-thin provisioned volumes, this value is the
same as the volume's capacity. For thin provisioned volumes, it is the amount of capacity
used to store the volume's contents. Its value is also affected by Snapshot copies,
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deduplication, and other storage technologies. If the volume does not have usage
information available, this appears blank.

Stor age Pool
The name of the storage pool on which the internal volume resides.

Datastore

The name of data store residing on this volume.
Type

Type of internal volume, for example, FlexClone or FlexVol.
Thin Provisioned

A check mark indicates that the resource is thin provisioned.

Per for mance Policy
The level of performance threshold (for example, Global) set on this resource. For
example, maximum IOPS, response time, or throughput thresholds might be set for
specific resources and not use the global thresholds.
Space Guarantee
A vendor-specific indication of how the internal volume's space is allocated if thin
provisioning is used.
Deduplication Savings
Percentage value of the rate of deduplication in effect for the internal volume.
Clone Source
The name of the internal volume that this internal volume cloned. This is the source of the
cloned relationship.
Clone Shared Capacity (GB)

When the Internal Volume is a clone of another Internal Volume, this value shows the
amount of capacity that is shared between the Source and Target clones (If no changes
have been made to the source and target Internal Volumes since the clone operation
occurred, all capacity will be shared. Modifications made to either of the Internal Volumes
will decrease the shared capacity).

Status

Information about whether the internal volume is online, offline, or OK.
Snapshot Reserve (GB)

The capacity that was reserved for Snapshot copies.
Snapshot Used (GB)

The capacity remaining after some capacity that was reserved for Snapshot copies was
actually used.

Snapshot Used (%)

The percent of capacity remaining after some capacity that was reserved for Snapshot
copies was actually used.

Snapshot Overflow (GB)
The capacity that was used for Snapshots, but exceeded what was reserved for Snapshot
copies.
Snapshot Count
The number of Snapshot copies that are stored for this internal volume.
Last Snapshot
The time when the last Snapshot copy operation occurred on this internal volume.
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Disk Types
The types of physical disks (for example, Fibre Channel or ATA) on which the internal
volume is based.

Disk Size (GB)
The size of the physical disks on which the internal volume is based.

Disk Speed (RPM)
The speed (RPM) of the physical disks on which the internal volume is based.

Response Time
The time that it took to access the disk. These values are based on fixed speed
specifications of the disks.

Response Time (R& W)
The time it takes from the moment a request for information arrives at the storage device
to the time when the storage devices begin to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.

Top Response Time
The maximum length of time it took for the internal volume to begin to send the response.

IOPS
The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/0 per sec).

|OPS (R& W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Top 1OPS
The maximum number of I/O service requests generated by the internal volume over the
selected length of time.

Throughput (R& W)
Rate at which data is read or written in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Top Throughput

Maximum rate at which Read or Write data can be received in a fixed amount of time in
response to 1/0 service requests (measured in MB per sec).

Accessed
“Yes” indicates that the resource was accessed in the selected time range.
annotations

User-defined terminology associated with the internal volumes including Service Level,
Note, and Tier.
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Internal Volume Usage of Storage Pool view

You can use the Internal Volume Usage of Storage Pool view to examine additional information for
each internal volume in the Storage Pool Utilization Violations view.

Navigation

From the OnCommand Insight Open menu, select Assurance > Storage Pool Utilization Violations.
At the bottom of the view, click the Internal Volume Usage of Storage Pool icon.

Column descriptions
blank

Organizes the data according to the selected grouping format. Applicable with any
presentation order other than No Grouping.

Name
Specifies the name of internal volume.
Hosts
Specifies hosts associated with the internal volume.
Application
Specifies applications associated with this internal volume.
Application Priority
Specifies the importance of this application as defined when establishing the business
entities.
Tenant, Line of Business, Business Unit, Project
List the business entity components associated with the applications.

Internal Volume IOPS
Measures the total number of I/O service requests on the internal volume during the time
of the utilization violation (measured in 1/O per sec).

Internal Volume Throughput

Specifies the rate at which data was transferred to and from the internal volume in
response to 1/0 service requests during the time period of the utilization violation
(measured in MB per sec).

Internal Volume Response Time

Specifies the time it takes from the moment a request for information arrives at the storage
device to the time when the storage devices begin to send the information back in
response. This is the actual latency of the device, based on live samples whenever
possible. OnCommand Insight measures response times from within the storage array. The
value is measured in milliseconds.

Internal Volume Top Response Time
Specifies the maximum length of time it takes to begin sending back a response.

Performance Chart

You can view performance trends over time to determine the cause of a violation in the Performance
Chart. It also allows you to examine the various performance metrics over a specified period and
narrow your search using the detailed information displayed when you position the mouse pointer
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over points in the chart. You can display the Analyze dialog box for those points in the Performance
Chart.

Navigation

* From the Host Performance, Virtual Machine Performance, Datastore Performance, Switch Port
Performance, or Storage Performance view, click the Performance Chart icon.

* Inthe Analyze dialog box, select one or more items on the Disks, Volumes, Internal Volumes,
Backend Volumes, Hosts, Datastores, Virtual Machines, VMDKSs, or Switch Ports tab and click
the Performance Chart icon.

Descriptions

If automatic storage tiering would display incorrect data, no data appears on the chart. For details,
click the Auto tiering affects data link.
Show Change Events

Select this option to display letters as change event markers on the chart. Clicking on the
markers highlights the change event in the list. The change events on the list give a brief
description of what the change involved and at what time the change was detected by
OnCommand Insight. Clicking on the description link opens the Changes detail view that
gives the full details of the changes that occurred at that time point.

Pan

Click the hand icon and move the mouse pointer over the performance chart to display
details for any point in the graph and right-click to open the Analyze dialog box for that
point.

L egend

Displays the metrics displayed on the chart that show performance thresholds and
utilization types.

Time Range
Changes the time period for the chart. You can select the following time ranges: Live
Sample, Today, Last Hour, Last 24h, Last Week, All, and Custom.
» With the Custom range, you can select any time range up to the current time.

*  With the Live Sample, OnCommand Insight first retrieves data for the last hour, then
asks the server for changes from the last update time to the current time based on the
following, as long as the chart is visible.

° VM data: 5 to 15 minutes

o Switch performance data: 5 to 15 minutes
o Storage arrays data: 5 to 15 minutes

o Configuration changes: 40 minutes

Dateand Time Stamp on x axis

The x axis displays the date and time when OnCommand Insight sampled and retrieved
the data.

Zoom

The y axis automatically scales to 5x greater than the greatest value in the chart. In
addition, you can zoom into a portion of the chart using the Zoom tool. To zoom in, click
the Zoom tool and click and drag across a section of the chart. A box defines the
boundaries of the detail that you will zoom into. To zoom out, hold down the Shift key and
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drag across a region. To reset the default zoom, click the Zoom to Fit tool. These settings
remain each time you view the Performance Chart.

Move the mouse pointer over the chart points to display additional information about that specific
point in the chart. You might also want to right-click on a chart point and display the Analyze
information for it. If you position the mouse pointer on an item in the legend, the minimum and
maximum points for that part of the chart are shown.

Related concepts

Performance trend analysis on page 13

Related tasks

ldentifying performance trends on page 22
Analyzing virtual storage performance on page 36

Performance Distribution view

The Performance Distribution view illustrates traffic distribution on the selected device using a
variety of the distribution analysis metrics.

Navigation

From the OnCommand Insight Open menu, select Perfor mance and the Host Performance, Virtual
Machine Performance, Datastore Performance, or Switch Port Performance view. Select one or more
lines in the view. Click the Perfor mance Distribution icon.

Descriptions

Each selected device is represented by a different color in the distribution chart. The legend
identifying each color is to the right of the distribution chart.

Changing the selected devices in the view changes the distribution display to the newly-selected
devices.

Move the mouse pointer over the distribution chart points to display additional information about
specific points in the chart.

If automatic storage tiering would display incorrect data, no data appears on the chart. For details,
click the Auto tiering affects data link.

Metric

For the Switch Port Performance data, you can filter the traffic data displayed on the chart
by selecting one of the following metrics:

o Traffic

e Loss of Sync
e Loss of Signal
o Tx Traffic

* Rx Traffic

Related concepts

Performance trend analysis on page 13
Automatic storage tiering in Inventory and Performance views on page 47
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Related tasks

Viiewing virtual machine performance and utilization on page 25
Exporting performance data as an image or file on page 23

Port Performance Distribution view

The Port Performance Distribution view illustrates traffic distribution on the selected port using
distribution analysis metrics. You can select the specific traffic or loss of sync or signal metrics that
you want charted.

Navigation

From the OnCommand Insight Open menu, select Performance > Switch Port Performance. Select
one or more of the port descriptions. Click the Port Perfor mance Distribution icon to display this
chart for the selected ports.

Descriptions

Select a metric for the distribution analysis from these options:
» Traffic Rate

* Rx Traffic Rate

* Tx Traffic Rate

» BB Credit Errors

e Loss of Sync

* Loss of Signal

Each selected port is represented by a different color in the distribution chart. The legend identifying
each port color is to the right of the distribution chart.

Changing the selected ports in the Switch Port Performance view changes the distribution display to
the newly selected ports.

Move the mouse pointer over the distribution chart points to display additional information about that
specific point in the chart.

Related tasks

Monitoring Fibre Channel switch performance on page 16
Selecting an active path for a virtual machine data store on page 28
ldentifying out-of-balance network traffic across host ports on page 39

Settings for Host Virtualization policies

You can set a policy that monitors for active/passive volume multipathing, for identical volume
access for hosts in a virtual cluster, and for identical volume LUN for virtual cluster hosts.

Navigation

From the Client menu, select Tools > Settings. In the left tree of the Settings view, click the Policies
> Host Virtualization option.
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Field descriptions
The Host Virtualization policy is enabled by default on all hosts.
Single storage processor for volume active paths

Alerts the SAN administrator that a volume is being actively accessed via multiple storage
processors. For storage arrays that maintain active/passive multipathing, this will result in
storage performance degradation (and even service interruption).

Storage models

If you enabled the Single storage processor for volume active paths option, select the
storage models that are active/passive and that should not allow access through multiple
storage processors to the same volume.

I dentical volume access for hosts within a virtual cluster

Alerts the SAN administrator that some hosts in a virtual cluster cannot access volumes
other members of the group can. Such a configuration may cause these hosts to be unable
to run virtual machines that other hosts in the cluster are able to run. (This is also
applicable for NAS shares.)

Identical volume LUN for hosts within a virtual cluster

Alerts the storage administrator that a volume is presented to different members of a
virtual cluster using different LUNSs.

Settings for VM Hosts Thresholds

You can use the VM Hosts Thresholds view to set the range of Hypervisor performance threshold
values that show up in green, yellow, or red on the virtual machine Performance views, which display
the HV utilization of virtual machine hosts (ESX servers) over a selected period.

Navigation

From the Client menu, select Tools > Settings. In the left tree of the Settings view, click the
Thresholds> VM Hosts Thresholds option.

Field descriptions
You should set each field's threshold as a Low and High value pair. The actual values in comparison
with these Low and High thresholds are catergorized and displayed as follows:
e Optimal
Values below the threshold's low value are displayed in green.

e Warning
Values below the threshold's high value are displayed in yellow.

e Error
Other values, such as those above the threshold's high value, are displayed in red.

The settings for VM Hosts Thresholds affect the colors on the following views: Datastore
Performance view, Virtual Machine Performance view, VMDK view, and Host Performance view.
Latency (ms)

Average amount of time for a read/write operation from or to the virtual disk before an
alert is issued. The default threshold values for this field are Low 20 and High 100.

CPU Utilization (%)
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Threshold for the host's CPU MHz being used. The default threshold values for this field
are Low 45 and High 75.

Memory Utilization (%)

Threshold for the memory used by the host. The default threshold values for this field are
Low 35 and High 65.

Storage Performance view

The Storage Performance view includes information about the internal volumes, and shows the
rounded sum of each internal volume in the array. You use this view to examine the performance
details for disks, volumes, and internal volumes.

Navigation

From the OnCommand Insight Open menu, select Perfor mance > Stor age Per for mance.

Column descriptions
blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name
Name of the storage array.

Technology
The SAN (FC and iSCSI) or NAS (NFS and CIFS) protocols that the device supports.
icon (array virtualization type)

The icon in this column indicates whether the storage acts as a virtualizer device (V) or as
back-end storage (B).

Capacity (GB)
Total storage array capacity that is accessible to host applications, in gigabytes.
Raw Capacity (GB)

The physical disk capacity, in gigabytes. This differs from usable capacity when
technologies such as RAID are used, where some of the raw capacity is used for
protection purposes.

Vendor

Name of the storage array vendor.
Family

Name of the storage array family.
M odel

Name of the storage array model.

Volume Response Time
The time that it takes to access the volume. These values are based on fixed speed
specifications of the volumes.

Volume Response Time (R& W)

The time it takes from the moment a request for information arrives at the storage device
to the time when the storage device begin to send the information back in response. This is
the actual latency of the device, based on live samplings whenever possible. OnCommand
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Insight measures response times from within the storage array. The value is measured in
milliseconds.

Top Volume Response Time
The maximum length of time it can take from the moment a request for information
arrives at the storage device until the time when the storage device begins to send the
information back in response.

Volume |OPS
Measures the total number of 1/O service requests on the virtual volume during the time
period of the utilization violation (measured in 1/O per sec).

Volume | OPS (R& W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Top Volume lOPS
The maximum number of I/O service requests generated by a single volume (across all
storage volumes) over the selected duration.

Volume Throughput
Rate at which data was transferred to or from the volume in response to 1/O service
requests during the time period of the utilization violation (measured in MB per sec).

Volume Throughput (R& W)
Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Top Volume Throughput
The maximum rate that data can be transmitted in a fixed amount of time to or from the
volume.

Volume Cache Hit Ratio

Percentage of requests that result in cache hits. The higher the number of hits versus
accesses to the volume, the better the performance. This column is empty for storage
arrays that do not collect cache hit information.

Volume Cache Hit Ratio (R& W)
Percentage of read or write requests that result in cache hits. The higher the number of hits
versus accesses to the volume, the better the performance.

Volume Partial R/W

Total number of times that a read or write request crosses a stripe boundary on any disk
module in RAID 5, RAID 1/0 or RAID 0 LUN. Generally, stripe crossings are not
beneficial, because each one requires an additional I/0. A low percentage indicates an
efficient stripe element size. Indication of improper alignment of a volume (or a NetApp
LUN). For CLARIION, this is the number of stripe crossings divided by the total number
of IOPS.

Write Pending
The number of Write 1/O service requests that are pending.

Volume Accessed
“Yes” indicates that the resource was accessed in the selected time range.

Internal Volume Response Time

The time it takes from the moment a request for information arrives at the storage device
until the time when the storage device begins to send the information back in response.
This is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.
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Internal Volume Response Time (R& W)

The time it takes from the moment a read or write request arrives at the storage device to
the time when the storage device begins to send the information back in response. This is
the actual latency of the device, based on live samplings whenever possible. OnCommand
Insight measures response times from within the storage array. The value is measured in
milliseconds.

Top Internal Volume Response Time

The maximum time it takes from the moment a request for information arrives at the
storage device until the time when the storage device begins to send the information back
in response.

Internal Volume lOPS

Measures the total number of 1/O service requests passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Internal Volume IOPS (R& W)

The number of Read or Write 1/O service requests passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/O per sec).

Top Internal Volume |OPS

The maximum number of 1/O service requests generated by a single internal volume
(across all storage internal volumes) over the selected duration.

Internal Volume Throughput
Rate at which data was transferred to or from the internal volume in response to 1/0
service requests during the time period of the utilization violation (measured in MB per
Sec).

Internal Volume Throughput

Rate at which data was transferred to or from the internal volume in response to 1/0
service requests during the time period of the utilization violation (measured in MB per
sec).

Internal Volume Throughput (R& W)

Amount of Read or Write data that is being received in a fixed amount of time in response
to 1/O service requests (measured in MB per sec) for the internal volume.

Top Internal Volume Throughput

The maximum rate that data can be transmitted in a fixed amount of time to or from the
internal volume.

Internal Volume Accessed
“Yes” indicates that the resource was accessed in the selected time range.
Disk Utilization

The percentage of post-cache service time used for requests out of the available sample
time. This metric indicates what portion of time the disk is busy servicing requests.

Disk Utilization (R& W)

The number of Read or Write 1/O service requests showing how the disk allocation is
being used.

Top Disk Utilization

The maximum percentage of the total disk pre-cache Service Time generated by a single
disk (across all storage disks) over the selected duration.

Disk IOPS

Measures the total number of 1/0 service requests on the disk for the virtual volume
during the time period of the utilization violation (measured in 1/O per sec).
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Disk |OPS (R& W)

The number of Read or Write 1/O service requests passing through the disk's 1/0 channel
or portion of that channel per unit of time (measured in 1/O per sec).

Top Disk IOPS
The maximum sum of 10PS reported by the measured disks.

Disk Throughput

Rate at which data was transferred to/from the disk in response to 1/0O service requests on
the virtual volume during the time period of the utilization violation (measured in MB per
Sec).

Disk Throughput (R& W)

Amount of Read or Write data that is being received in a fixed amount of time in response
to 1/O service requests (measured in MB per sec) for the disk.

Top Disk Throughput

The maximum rate that data can be transmitted in a fixed amount of time to or from the
disk.

Disk Accessed
Indication whether at least one disk was accessed (for read or write).

icon (Isthe device offline?)
An icon in this column indicates that the device is offline.

<annotations>
User-defined terminology associated with the devices.

Related tasks

ldentifying performance trends on page 22
Analyzing virtual storage performance on page 36

Storage Pool Performance view

With the Storage Pool Performance view, you can see how well storage virtualization is performing.
A detailed comparison can be done by individually examining absolute front-end and backend values.

Navigation
From the OnCommand Insight Open menu, select Performance > Stor age Perfor mance. Click the
Storage Pool Performance icon.

Column descriptions
blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name

The name of the storage pool.
Storage

The name of the storage system controlling the storage pool.
Nodes

Names of nodes on which the storage pool resides.
Application
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The names of the applications using the storage pool.
Application Priority

Importance of this application as defined when establishing the business entities.
Tenant, Line of Business, Business Unit, Project

Columns listing the business entity components associated with the applications.

Hosts
Names of the hosts associated with the storage pool.

Type
The type of storage pool, for example, Aggregate for NetApp storage systems, RAID
group, Thin Provisioning for a thin provisioned storage pool, or Backend Group for array
virtualization.

Auto Tiering
A checkmark indicates that the selected storage pool is using the automatic storage tiering
technology (for example, FAST VP).

icon (Isvirtual?)
A "V" icon in this column indicates that the device is a virtualized volume.

Capacity (GB)
Size of the volume that is accessible to host applications, in gigabytes.

Used Capacity (GB)
The amount of capacity holding actual data in the storage pool. Includes usage based on
all file types.

Used Capacity (%)
The percentage of capacity consumed in the storage pool in gigabytes.

Unused Capacity (GB)
The usable capacity that might be available for storing additional data on the storage pool
in gigabytes.

Backend Capacity (GB)
The sum of the capacities of the backend storage used to store the storage pool. This
column applies only to virtual storage pools, whose storage is allocated on storage arrays
not directly controlled by the storage system identified in the Storage column.

Commit Ratio
The ratio of the total space on the storage pool to the capacity that is allocated from it.
This value can be greater than 100% when thin provisioning is in use (the pool is
overcommitted).

Utilization (R& W)
The portion of the total percentage of pre-cache Service Time used for service requests out
of the selected time range.

Top Utilization
The maximum number of service requests.

Response Time

The time it takes from the moment a request for information arrives at a storage device to
the time when the storage device begins to send the information back in response,
measured in milliseconds. The actual calculation of response time depends on the device
vendor.

Response Time (R& W)
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The time it takes for a read or write request to arrive at the storage device and to respond
to the request.
Top Response Time
The maximum of the maximum response times reported by the measured devices.
IOPS
The rate at which input and output operations are directed at a storage device. Each
operation might have a large or small amount of data transferred for it. The actual
calculation of IOPS depends on the device vendor.
IOPS (R& W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).
Top IOPS
The maximum sum of 10PS reported by the measured devices.

Throughput
The rate at which data is sent to a storage device in a fixed amount of time. The value is
measured in megabytes per second. The actual calculation of throughput depends on the
device vendor.

Throughput (R& W)
The rate at which data is read or written to a storage device in a fixed amount of time. The
value is measured in megabytes per second. The actual calculation of throughput depends
on the device vendor.

Top Throughput
The maximum sum of throughputs reported by the measured devices.

Backend Response Time
The time it takes from the moment a request for information arrives at the backend
volumes to the time when the storage device begins to send the information back in
response, measured in milliseconds. The actual calculation of response time depends on
the device vendor. This column is only populated for virtual storage pools.

Backend Response Time (R& W)
The time it takes for a read or write request to arrive at the backend volumes and to
respond to the request.

Top Backend Response Time
The maximum of the maximum response times reported by the backend volumes. This
column is only populated for virtual storage pools.

Backend 1OPS

The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec). This column is only
populated for virtual storage pools.

Backend I0OPS (R& W)

The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Top Backend 1OPS

The maximum sum of I0PS reported by the backend volumes. This column is only
populated for virtual storage pools.

Backend Throughput
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The rate at which data is read or written to the backend volumes in a fixed amount of time.
The value is measured in megabytes per second. The actual calculation of throughput
depends on the device vendor. This column is only populated for virtual storage pools.

Backend Throughput (R& W)
The rate at which data is read or written to the backend volumes in a fixed amount of time.
The value is measured in megabytes per second. The actual calculation of throughput
depends on the device vendor.

Top Backend Throughput
The maximum sum of throughputs reported by the backend volumes. This column is only
populated for virtual storage pools.

| OPS Efficiency
The ratio of IOPs to Backend IOPS. This indicates the efficiency gained by virtualization.
For example, if there are 100 front-end (backend plus non-backend) 10PS and 25 backend
IOPS, then the ratio is (100 - 25)/100 = 75%. This means 75% of the 1/O requests were
handled within the virtualizer and 25% required 1/O to backend storage. A negative
number indicates that the overhead of virtualization (housekeeping operations) outweighs
the gain of virtualization. This column is only populated for virtual storage pools.

| OPS Efficiency (R& W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

Throughput Efficiency
The ratio of Throughput to Backend Throughput. This column is only populated for
virtual storage pools.

Throughput Efficiency (R& W)
The ratio of Throughput to Backend Throughput read and write requests. This column is
only populated for virtual storage pools.

Accessed
"Yes" indicates that the resource was accessed in the selected time range.

Backend Accessed
"Yes" indicates that the backend resource was accessed in the selected time range.

annotations
The annotations associated with these devices.

Options

From the Storage Pools Performance detail view, right-click to show a pop-up menu containing the
following options.

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance. The Storage Pool Summary tab provides
information that might be needed for troubleshooting.

Analyze Storage Pools

Available only with the Assure license. Allows you to select a specific storage pool and
assess its status related to the thin-provisioning policies. You can use this dialog box,
instead of the Violations Browser, to see the current thin provisioning violations and how
close the storage pool is to reaching the policy limits.

Show Disks
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Shows all disks used by the selected storage pool in a separate view and provides the
capacity information for the storage pools

Edit Annotations

Allows you to assign a note to this resource so that you can later group or filter the
resources by the annotation. For example, you might want to group or filter resource by a
specific note or tier.

Storage Resource Performance chart

This view enables you to see how well the storage resources that have already been allocated are
performing.

Navigation
From the OnCommand Insight Open menu, select Performance > Datastore Performance. Select
one or more lines in the view. Click the Storage Resour ce Per for mance icon.

Descriptions
Show Change Events

Select this option to display letters as change event markers on the chart. Clicking on the
markers highlights the corresponding change events in the list. The change events on the
list briefly describe what the change involved and when the change was detected by
OnCommand Insight. Clicking on the description link opens the Changes detail view that
gives more information about the changes that occurred at that point.

Pan

Click the hand icon and move the mouse pointer over the performance chart to display
details for any point in the graph, and right-click to open the Analyze dialog box for a
selected point.

L egend
Displays the metrics shown on the chart that include 10PS, throughput, and response time
data. Click Change to select different metrics to display in the chart.

Time Range

Changes the time period for the chart. You can select the following time ranges: Live
Sample, Today, Last Hour, Last 24h, Last Week, All, and Custom.

< With the Custom range, you can select any time range up to the current time.

« With the Live Sample, OnCommand Insight first retrieves data for the last hour, then
asks the server for changes from the last update time to the current time as long the as
the chart is displayed.

Date and Time Stamp on x axis

The x axis displays the date and time when OnCommand Insight sampled and retrieved
the data.

Zoom

The y axis automatically scales to 5x greater than the greatest value in the chart. In
addition, you can zoom into a portion of the chart using the Zoom tool. To zoom in, click
the Zoom tool and click and drag across a section of the chart. A box defines the
boundaries of the detail that you zoom into. To zoom out, hold down the Shift key and
drag across a region. To reset the default zoom, click the Zoom to Fit tool. These settings
persist across multiple viewings of the performance chart.

Export image or data



90 | OnCommand Insight Performance Guide

You can export the chart as a graphic file or export data from the chart.

Switch Port Performance view

The Switch Port Performance view displays traffic distribution data across the different devices on
the storage network, such as switches, hosts, and storage devices at any given point in time. Every
device is listed and can be sorted by data load as a percentage.

Use the Switch Port Performance view to:

» Evaluate traffic distribution.

» Evaluate port utilization.

 Identify resources that can be leveraged to improve utilization.
» Diagnose traffic bottlenecks.

« Diagnose congestion problems.

» Determine when to plan to add new capacity.

» Determine when to better utilize current capacity.

Navigation

From the Insight Open menu, select Performance > Switch Port Performance.

Column descriptions
This view displays data in these columns.

blank

Applicable with any presentation order other than No Grouping. Column that organizes
the data according to the selected grouping format (by, for example, device name,
connected device name). The number in parentheses indicates the number of ports
reported in each (grouped) row.

Switch

Name of the switch in the storage network.
Switch Port

Name of the switch port on the switch.
HasErrors

Number of errors for each host.
Value

The amount of traffic by the device indicated as being sorted by in the menu in the upper
right corner.

Rx Value
Value received.
Tx Value
Value transmitted.
Distribution
Percentage of the total load carried by the path.
Fabric/VSAN
Address of fabric or virtual storage area.
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VSAN
Name of Virtual Storage Area Network.
Speed
The physical speed (in gigabytes) of the switch port shown in this view.

Switch Blade

The physical, usually racked, chassis in which switch components reside. One switch
entity may contain multiple blades. One blade may contain multiple controllers.

Controller

An 1/0 controller board located in the blade container. A controller may service multiple
ports.

Transfer Rate

The average sampled transfer rate for the time period and metric selected in the view
(measured in MBs).

Rx Transfer Rate
Receiving rate.
Tx Transfer Rate
Transmission rate.
Connected Device Type
Type of device in the storage network, for example, switch, host, or storage array.
Connected Device Name
Name of the device in the storage network.
Connected Device Port
Name of the device port on the storage network.
V-Host
Name of the host virtualization server.
HasCRC Errors
Number of CRC frame errors.
Sync L oss Count
Number of synchronization loss errors.
Signal L oss Count
Number of signal loss errors.
Class 3 Discar ds Count
The count of Fibre Channel Class 3 data transport discards.
Frame Too Short Count
The count of Fibre Channel data transmission frames that are too short.
Frame Too Long Count
The count of Fibre Channel data transmission frames that are too long.
BB Credit Errors

Fibre Channel uses buffer-to-buffer credits to control transmission flow. The credit value
is decreased by one when a frame is sent and increased when a response is received. As
the available credits for a given port approach zero, the error warns that the port will stop
receiving transmissions when zero is reached and will not resume until the BB credits can
be replenished.

Application



92 | OnCommand Insight Performance Guide

The application or service that resides on the host.

Application Priority
Importance of this application as defined when establishing the business entities.

Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Options
The following options are available from the right-click menu:

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance.

Show Performance Histogram
Displays the relative amount of time the selected ports spent in the given utilization levels.

Show Daily Traffic Pattern
Identifies the flow of traffic by hour, day, week or by a custom calendar setting.

Related tasks

Monitoring Fibre Channel switch performance on page 16
Selecting an active path for a virtual machine data store on page 28
Determining if a VM is affecting host performance on page 30

Switch Threshold settings

You use the Switch Threshold settings to establish the minimum and maximum performance
thresholds that constitute policies. When a threshold level is reached, an alert is issued.

Navigation
You can change the threshold settings with the Tools > Settings > Switch Thresholds option.

If you want to locate a potential problem with switch performance, select Assurance > Switch Port
Performance Alerts. Right-click on a threshold shown in red and select the Configure option to
make changes.

Setting options

To set a switch threshold, set the following parameters in the tabbed groups of thresholds:

» Min: The minimum level that can be reached without an alert being issued. If a level reaches less
than this minimum for the specified time period, an alert is issued. To disable a threshold, clear
the check box.

e Max: The maximum level that can be reached without an alert being issued. If a level exceeds this
maximum for the specified time period, an alert is issued. To disable a threshold, clear the check
box.

» Period (minutes): The amount of time during which the error must occur for an alert to be issued.

Performance threshold settings
Tx Utilization (%)
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Percentage of available bandwidth used for sending transmissions.

Rx Utilization (%)
Percentage of available bandwidth used for receiving transmissions.

Utilization (%)
Percentage of available bandwidth used for Tx and Rx combined.

CRC (%)
The CRC frame errors as a percentage of the total data traffic. CRC frame errors indicate
bit errors somewhere in the data path and point to poor connections, bad cables, or links
that are too long.

Error (%)
The volume of errors as a percentage of the total data traffic.

Lossof Sync
If a Loss of Sync error occurs, the hardware cannot make sense of the traffic or lock onto
it. All of the equipment might not be using the same data rate or the optics or physical
connections might be of poor quality. The port must re-sync after each such error, which
impacts system performance.

L oss of Signal
If a Loss of Signal error occurs, there is no electrical connection and a physical problem
exists.

Class 3 Discards
The count of Fibre Channel Class 3 data transport discards.

Frame Size Too Long
The count of Fibre Channel data transmission frames that are too long.

Frame Size Too Short
The count of Fibre Channel data transmission frames that are too short.

BB Credit Errors

Fibre Channel uses buffer-to-buffer credits to control transmission flow. The credit value
is decreased by one when a frame is sent and increased by one when a response is
received. As the available credits for a given port approach zero, the error warns that the
port will stop receiving transmissions when zero is reached and will not resume until the
BB credits can be replenished.

Switch threshold types and formulas

OnCommand Insight uses these formulas to determine the switch port performance threshold data.

Threshold Description Formula
BB Credit Fibre Channel uses buffer-to-buffer credits to
Errors control transmission flow. The credit value is

decremented when a frame is sent and
replenished when a response is received. As the
available credits for a given port approach zero,
the error warns that the port will stop receiving
transmissions when zero is reached and will not
resume until the BB credits can be replenished.

Class 3 The count of Fibre Channel Class 3 data
Discards transport discards.
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Threshold Description Formula
CRC Rate CRC Rate is the measure of CRC frame errors
as a percentage of the total data traffic. creErrorRate =-2CTcErTors 100

. ) ) ARxFrames
CRC frame errors indicate bit errors

somewhere in the data path and point to poor g e >

connections, bad cables, or links that are too

long. w
Errors Rate Total number of errors (Loss of Sync, Loss of

Signal, and Framing) —— Aerror 100

Aerror + ARxFrames + ATxFrames

Frame Size The count of Fibre Channel data transmission
Too Long frames that are too long.
Frame Size The count of Fibre Channel data transmission
Too Short frames that are too short.

Loss of Signal | If a Loss of Signal error occurs, there is no
electrical connection and a physical problem
exists.

AlossQfSignal 100

lossOfSignal / sec(%) =
Asec

Loss of Sync | If a Loss of Sync error occurs, the hardware
cannot make sense of the traffic or lock onto it. " AlossOfSine 100
g . N ossOfSync /sec(%) = —————
All of the equipment might not be using the Bsec
same data rate or the optics or physical

connections might be of poor quality.

The port must re-sync after each such error,
which impacts system performance.

Received Percentage of available bandwidth used for Rx.
Utilization RxUtilization(%) = M T
ASeconds ActualSpeedBits

Transmit Percentage of available bandwidth used for Tx.
Utlllzat'on TxUtilization(%) :%
ASeconds ActualSpeedBits

Utilization Percentage of available bandwidth used for Tx
and Rx. max(ARxBirs, ATxBits) 100

Utilization(%) =
ASeconds AcnialSpeedBits

Topology view

Use this view to visualize your SAN or NAS environment, the devices, and their connections. Every
device in your environment is shown as an icon that represents the device type, while physical
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connections appear as lines connecting the devices. Each time you select a different device or path in
a main view, the Topology representation changes as well.

Access

You can display a Topology map from the majority of the main views; however, you cannot access
the Topology Map from the Switches, Storage Arrays, or Tapes main views. From a main view, select
a device or path and click the Topology icon in the bottom of the Client view.

Operations

From the Topology view, you can perform the following operations:
 Position the mouse pointer over a device or path to see its detail.
» Click any device icon to view port information.

» Use the Topology toolbar to adjust settings.

» Select different view representations on the Topology Map.

» Change the link style to rounded or square.

* Add a watermark to the map.

* Add connected devices.

» Export the Topology layout as an image.

Related tasks

Allocating capacity to an existing hoston page 45

Related references

Analyze dialog box on page 47

VMDK Performance view

Use this view to determine which disks are the top consumers of I0OPS. From this list, you can choose
the top consumers and use the VM Performance Distribution Chart to compare their IOPS.

Navigation

» From the Insight Open menu, select Performance > Virtual Machine Performance. Click the
VMDK Performance view icon.

Column descriptions

blank

Column that organizes the data according to the selected grouping format (by, for
example, device name, connected device name). Applicable with any presentation order
other than No Grouping. The number in parentheses indicates the number of ports
reported in each (grouped) row.

Name

Name of the virtual machine disk.

Virtual Machine
Name of virtual machine.
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Datastore
The name of data store residing on this virtual machine disk.

Capacity (GB)
Total storage array capacity that is accessible to host applications, in gigabytes.

Used Capacity (GB)
The amount of capacity holding actual data in the virtual machine disk. Includes usage
based on all file types.

RDM
A VMware feature that exposes SCSI targets (or LUNS) directly to a virtual machine.
RDMs are an alternative to using VMFS. RDMs are special files in a VMFS volume that
act as a proxy for a raw device.

Host Names
Hosts associated with the virtual machine disk.

Storage
Storage arrays used by this virtual machine disk.

Resource Name
The volumes or internal volumes in the path.

Resour ce Technology
The SAN (FC and iSCSI) or NAS (NFS and CIFS) protocols that the device supports.

Resource Capacity (GB)
The total capacity, in gigabytes of the volumes or internal volumes, in the paths of this
virtual machine storage pool.

Resource Used Capacity (GB)
The total used capacity, in gigabytes of the volumes or internal volumes, in this virtual
machine paths.

Deduplication Savings
The known amount of storage savings through deduplication, a process that detects blocks
with identical content and replaces subsequent identical blocks with a reference to a single
copy of the block.

IOPS (R&W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/0 per sec).

IOPS
The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in /O per sec).

Top 1OPS
The maximum sum of 10PS reported by the measured devices.

Throughput (R& W)
The rate at which data is read or written to the measured devices in a fixed amount of
time. The value is measured in megabytes per second. The actual calculation of
throughput depends on the device vendor.

Throughput
Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Top Throughput
The maximum sum of throughputs reported by the measured devices.
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Latency (R& W)

The rate at which data is read or written to the virtual machines in a fixed amount of time.
The value is measured in megabytes per second.

Latency
The average response time from the virtual machines carved from a data store.

Top Latency
The highest response time from the virtual machines carved from a data store.

Options
The following options are available from the right-click menu:

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected virtual machines. For example, you can determine contention issues, availability
issues, and performance.

VM Distribution view

This view lists the virtual machines using the selected virtual machine (VM) in their data path and
their estimated 1/O traffic distribution on the VM.

Navigation
From the OnCommand Insight Open menu, select the Switch Port Performance view, select a
virtual machine, and click the VM Distribution icon.

Column descriptions

VM

The name of the selected virtual machine.
Datastore

The name of data store used by this virtual machine.
Host Port

The name of the port used on the host by this virtual machine.
Storage Port

The name of the port the virtual machine uses on the storage device.
Volume

The name of the volume this virtual machine uses in the storage device.
/0

The total throughput of this virtual machine.

I/O Distribution

The estimated percentage contribution of this particular virtual machine to the total traffic
on this port originating from any virtual machine.
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Virtual Internal Volume Performance view

You use this view to see the details of the virtual internal volume involved in a Storage Pool
Utilization Violation.

Navigation

1. From the OnCommand Insight Open menu, select Assurance > Storage Pool Utilization
Violations.

2. Select one or more items in the view. Click the Volume Usage of Storage Pool icon.
3. Click the Virtual Internal Volume Performance icon.

Alternately, right-click on any Performance view and select Analyze. The Disks tab has Volume
Usage and Internal Volume Usage detail views from which you select the Virtual I nternal Volume
Performance icon.

Column descriptions
blank

Applicable with any presentation order other than No Grouping. Column that organizes
the data according to the selected grouping format.

Name

Name of the virtual volume.
Storage

Name of storage array on which the virtual volume resides.
SVM/vFiler

The name of the SVM or vFiler unit. The unit is an isolated software container that
behaves exactly like a physical storage array. It shares the physical resources of the array,
but abstracts the client access from the physical array into virtual arrays.

Nodes

Names of nodes on which the virtual volume resides.
HA Partner

Name of the high-availability volume paired with this virtual volume.
Application

Applications associated with this virtual volume.
Application Priority

Importance of this application as defined when establishing the business entities.
Tenant, Line of Business, Business Unit, Project

Columns listing the business entity components associated with the applications.
Hosts

Hosts making use of the virtual internal volume.
Capacity (GB)

Total storage array capacity that is accessible to host applications, in gigabytes.
Raw Capacity (GB)
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Physical disk capacity of the volume, in gigabytes. This differs from usable capacity when
technologies such as RAID-5 are used, where some of the raw capacity is used for
protection purposes.

Used Capacity (GB)
The amount of capacity holding actual data in the virtual machine disk. Includes usage
based on all file types.

Consumed Capacity

The amount of capacity that the volume consumes from underlying storage. For non-thin
provisioned value, that is the same as the volume capacity. For thin provisioned volumes,
it is the amount of capacity used to store the contents on the volume. Its value is also
affected by Snapshot copies, deduplication, and other storage technologies. If the volume
does not have usage information available, this appears blank.

Storage Pool

Storage arrays used by this virtual machine disk.
Datastore

The name of data store residing on this internal volume.
Type

Type of internal volume, for example, FlexClone or FlexVol.
Flash Pool

Flash pool used by this virtual machine disk.

Thin Provisioned
A check mark indicates that the resource is thin provisioned.

Per for mance Policy
The level of performance threshold (for example, Global) set on this resource. For
example, maximum IOPS, response time, or throughput thresholds might be set for
specific resources and not use the global thresholds.
Space Guarantee
A vendor-specific indication of how the internal volume's space is allocated if thin
provisioning is used.
Deduplication Savings
Percentage value of the rate of deduplication in effect for the internal volume.
Clone Source
The name of the internal volume that this internal volume cloned. This is the source of the
cloned relationship.
Clone Shared Capacity (GB)

When the Internal Volume is a clone of another Internal \olume, this value shows the
amount of capacity that is shared between the Source and Target clones (If no changes
have been made to the source and target Internal Volumes since the clone operation
occurred, all capacity will be shared. Modifications made to either of the Internal Volumes
will decrease the shared capacity).

Status

Information about whether the internal volume is online, offline, or other status.
Snapshot Reserve (GB)

The capacity that was reserved for Snapshot copies.
Snapshot Used (GB)

The capacity remaining after some capacity that was reserved for Snapshot copies was
actually used.
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Snapshot Used (%)
The percent of capacity remaining after some capacity that was reserved for Snapshot
copies was actually used.

Snapshot Overflow (GB)
The capacity that was used for Snapshots, but exceeded what was reserved for Snapshot
copies.

Snapshot Count
The number of Snapshot copies that are stored for this internal volume.

Last Snapshot
The time when the last Snapshot copy operation occurred on this internal volume.

Disk Types
The types of physical disks (for example, Fibre Channel or ATA) on which the internal
volume is based.

Disk Size (GB)
The size of the physical disks on which the internal volume is based.

Disk Speed (RPM)
The speed (in revolutions per minute) of the physical disks on which the internal volume
is based.

Response Time
The time in milliseconds that it took to access the disk. These values are based on fixed
speed specifications of the disks.

Response Time (R& W)
The time it takes from the moment a request for information arrives at the storage device
to the time when the storage devices begin to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.

Top Response Time
The maximum length of time in milliseconds that it took for the internal volume to begin
to send the response.

IOPS

The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/0 per sec).

|OPS (R& W)

The number of Read and Write 1/0O service requests passing through the 1/0 channel or
portion of that channel per unit of time (measured in 1/0 per sec).

Top IOPS

The maximum number of 1/O service requests generated by the virtual internal volume
over the selected length of time.

Throughput

Rate at which Read or Write data can be received in a fixed amount of time in response to
1/0 service requests (measured in MB per sec).

Throughput (R& W)

Rate at which data is read or written in a fixed amount of time in response to /O service
requests (measured in MB per sec).

Top Throughput
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Maximum rate at which Read or Write data can be received in a fixed amount of time in
response to 1/0 service requests (measured in MB per sec).

Accessed
“Yes” indicates that the resource was accessed in the selected time range.
annotations

User-defined terminology associated with each virtual internal volume including Service
Level, Note, and Tier.

Virtual Machine Performance view

Use this view to look for inactive VMSs or VMs that are using high storage that could be using lower-
tier storage.

Navigation

From the OnCommand Insight Open menu, select Performance > Virtual Machine Performance.

Column descriptions
It might be helpful to group the data by data stores. One VM can access multiple data stores.

With this view, you can select a VM and see additional data in other views:

» Select multiple VMs and with the VM Performance Distribution detail view, you can compare
traffic distribution and identify which VM is generating the most 10PS.

» With the Virtual Machines Performance Chart, you can see how the load (CPU or memory) is
distributed across the VMs on a specific ESX host and see if there are sudden changes or
anomalies.

blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Name

Name of virtual machine. This view does not display information about virtual machines
and LUNs that do not map to a volume.

DNS Name

The host domain name.
Host Names

Names of hosts using the virtual machine.
Datastore

The name of data store using the virtual machine.
V-Cluster

Name of the cluster.
CPU Utilization

Amount of actively used CPU, as a percentage of total available (over all virtual CPUs).
Memory Utilization

Threshold for the memory used by the host.

Disk Latency
The sum of Disk Read Latency and Disk Write Latency for the sampling period.
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Top Disk Latency
The maximum (over all virtual disks) amount of time taken for a virtual disk write
operation (ms).

Disk Read L atency

Average amount of time taken during the interval to process a SCSI read command issued
from the Guest OS to the virtual machine. Latency data is derived from the VMDK.

Disk Write Latency

Average amount of time taken during the interval to process a SCSI write command issued
by the Guest OS to the virtual machine. The average (over all virtual disks) amount of
time taken for a virtual disk write operation (ms).

Disk I0OPS
The sum of Disk Read I0PS and Disk Write IOPS.
Top Disk IOPS
The maximum sum of 10PS reported by the measured disks.

Disk Read | OPS

The number of read 1/O service requests passing through the disk's 1/0 channel or portion
of that channel per unit of time (measured in 1/O per sec).

Disk Write |OPS
Number of disk write operations (across all disks) per second in the latest poll.
Disk Throughput
Aggregated disk 1/0 rate (MB/s).
Top Disk Throughput
The maximum rate that data can be transmitted in a fixed amount of time to/from the disk.
Disk Read Throughput
Total averaged rate to read from the disk in megabytes per second.
Disk Write Throughput
Total averaged rate written to the disk in megabytes per second.
IP Throughput
Aggregated rate at which IP data was transmitted and received in megabytes per second..
I P Throughput (Receive)
Average rate at which IP data was received in megabytes per second.
I P Throughput (Transmit)
Average rate at which IP data was transmitted in megabytes per second.
Disk Accessed
Indication if at least one virtual disk was accessed (for read or write).
I P Accessed
Indication if Guest OS received or transmitted any IP data.

Options
The following options are available from the right-click menu:

Analyze

Available only with the Perform license. Allows you to investigate the performance of the
selected resources affected by the violation. For example, you can determine contention
issues, availability issues, and array performance. The Virtual Machine Summary tab
provides information that might be needed for troubleshooting.



Performance reference | 103

Analyze Storage Pools

Available only with the Assure license. Allows you to select a specific storage pool and
assess its status related to the thin provisioning policies. You can use this dialog box,
instead of the Violations Browser, to see the current thin provisioning violations and how
close the storage pool is to reaching the policy limits.

Related tasks

Viewing virtual machine performance and utilization on page 25

Related references

Virtual Machine Summary tab on page 56

Virtual Volume Usage view

You use this view to see the details of the virtual volume involved in a utilization violation.

Navigation

From the OnCommand Insight Open menu, select Assurance > Storage Pool Utilization Violations.
Select one or more items in the view. Click the Volume Usage of Storage Pool icon. Click the
Virtual Volume Usage icon.

Column descriptions
blank
Applicable with any presentation order other than No Grouping. Column that organizes
the data according to the selected grouping format.
Volume
Name of the virtual volume.
L abel
Full virtual volume name within the storage array.
Type
The vendor-specific type of virtual volume (for example, SFS or B.V.).
array virtualization typeicon
Indicates type of virtualization. Showing on a virtual volume, a “V”" icon indicates that the
device is a virtualized volume, and a “B” icon indicates that the device is a back-end
volume.
Hosts
Hosts making use of the virtual volume.
Application
Applications associated with this virtual volume.
Application Priority
Importance of this application as defined when establishing the business entities.
Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Volume |OPS

Measures the total number of 1/O service requests on the virtual volume during the time
period of the utilization violation (measured in 1/O per sec).
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Volume Throughput
Rate at which data was transferred to or from the virtual volume in response to I1/O service
requests during the time period of the utilization violation (measured in MB per sec).
Volume Response Time
The time in milliseconds that it takes from the moment a request for information arrives at
the storage device to the time when that storage device begins to send information back in
response. This is the actual latency of the device, based on live samplings whenever
possible. OnCommand Insight measures response times from within the storage array.
Volume Top Response Time
The maximum time in milliseconds it takes to send the information back.

Volume Performance view

Using the Volume Performance view, you can see all the volumes that the hosts are using and the
metrics necessary to analyze volume performance. This data helps you better use capacity and assists
in proactive analysis of how the storage resources are being used. For SAN environments, the
Volume Performance view shows the end points of the SAN paths.

Navigation

* From the OnCommand Insight Open menu, select Performance and the Host, Storage,
Application, Datastore, or Virtual Machine performance views. At the bottom of the any of these
views, click the Volume Performanceicon.

» From one of the Performance views, select a row, right-click, and select Analyze. Click the
Volumestab.

Column descriptions

blank

Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Volume
Name of volume.
Label
An alternate name or alias assigned to a volume by the storage administrator.

uulibD

Universally unique identifier for the object. In this case, it is generated by and retrieved
from the storage array itself.

Storage
Name of the storage array.
Stor age Pool
The name of the storage pool on which the volume resides.

Auto Tiering

A checkmark indicates that the selected storage pool is using the automatic storage tiering
technology (for example, FAST VP).

Thin Provisioned
A checkmark indicates that the volume is leveraging thin provisioning.

Per formance Policy
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The level of performance threshold (for example, Global) set on this resource. For
example, maximum IOPS, response time, or throughput thresholds might be set for
specific resources and not use the global thresholds.

vFiler

The name of the vFiler unit. A vFiler unit is an isolated software container that behaves

exactly like a physical storage array. A vFiler unit shares the physical resources of the

array, but abstracts the client access from the physical array into virtual arrays.
Internal Volume

Name of the internal volume that the volume uses.

Qtree
Name of the gtree on this volume.

array virtualization typeicon
Indicates type of virtualization. Showing on a virtual volume, a "V" icon indicates that the
device is a virtualized volume and a "B" icon indicates that the device is a backend
volume.

Virtualizer
For backend volumes in array virtualization. Displays the name of the front end virtualizer
that is using this volume.

Virtual Storage Pool
For backend volumes in array virtualization. The name of the storage pool on the front end
virtualizer that is using this volume.

Datastore
The name of data store residing on this volume.

Application
Application associated with this volume.

Application Priority
The importance of this application within your organization that was set when defining the
application.

Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Hosts

Hosts making use of the volume.
Capacity (GB)

Size of the volume that is accessible to host applications, in gigabytes.
Raw Capacity (GB)

Physical disk capacity of the volume, in gigabytes. This differs from usable capacity when
technologies such as RAID-5 are used, where some of the raw capacity is used for
protection purposes.

Consumed Capacity (GB)

The amount of capacity that the volume consumes from underlying storage (for example,
internal volume and storage pool). For non-thin provisioned volumes, this value is the
same as the volume's capacity. For thin provisioned volumes, it is the amount of capacity
used to store the volume's contents. Its value is also affected by Snapshot copies,
deduplication, and other storage technologies. If the volume does not have usage
information available, this appears blank.

M apped Ports
The number of storage ports through which this volume is accessible.
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Redundancy
Level of mirroring defined for the device based on the storage technology, for example,
RAID-DP, underlying the device. This is taken from the device itself. For an explanation
of values, see the device documentation.

Response Time
The time it takes from the moment a request for information arrives at the storage device
to the time when the storage devices begin to send the information back in response.

Response Time (R& W)
The time it takes for a read or write request to arrive at the storage device and to respond
to the request.

Top Response Time
The maximum length of time it takes from the moment a request for information arrives at
the storage device to the time when the storage devices begin to send the information back
in response.

IOPS
The portion or ratio of 1/O service requests by the selected host or application passing
through the 1/0 channel per unit of time (measured in 1/0 per sec).

IOPS (R&W)
The number of Read or Write 1/O service requests passing through the 1/O channel or
portion of that channel per unit of time (measured in 1/O per sec).

Top IOPS
The maximum number of I/O service requests generated by the volume over the selected
length of time.

Throughput
Rate that data is being transmitted in a fixed amount of time in response to 1/O service
requests (measured in MB per sec).

Throughput (R& W)
Rate at which Read or Write data is being received in a fixed amount of time in response
to 1/0 service requests (measured in MB per sec).

Top Throughput
Maximum rate at which data can be received in a fixed amount of time in response to 1/O
service requests (measured in MB per sec).

Cache Hit Ratio

Percentage of requests that result in cache hits. The higher the number of hits versus
accesses to the volume, the better the performance. This column is empty for storage
arrays that do not collect cache hit information.

Cache Hit Ratio (R& W)

Percentage of Read/Write requests that result in cache hits. The higher the number of hits
versus accesses to the volume, the better the performance. This column is empty for
storage arrays that do not collect cache hit information.

Partial R/W

Total number of times that a read or write crosses a stripe boundary on any disk module in
RAID 5, RAID 1/0 or RAID 0 LUN. Generally, stripe crossings are not beneficial,
because each one requires an additional 1/0O. A low percentage indicates an efficient stripe
element size. A high percentage is often an indication of improper alignment of a volume
(or a NetApp LUN). For CLARIION, this is the number of stripe crossings divided by the
total number of IOPS.

Write Pending
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The number of Write 1/O service requests that are pending.
Accessed
"Yes" indicates that the resource was accessed in the selected time range.

annotations
Annotations associated with each volume.

Options

From the Volume Performance detail view, right-click to display a menu containing the following
options:

Analyze

Allows you to identify potential problems by isolating the location of contention and the
source of delays and by comparing performance data for different time periods to note
changes. The Volume Summary tab provides information that might be needed for
troubleshooting.

Analyze Stor age Pools

Allows you to select a specific storage pool and assess its status related to the thin-
provisioning policies. You can use this dialog box, instead of the Violations Browser, to
see the current thin provisioning violations and how close the storage pool is to reaching
the policy limits.

Show Disks
Shows all disks used by the selected storage pool in a separate view.

Show Volume Members
Lists the members of the volume in a separate window.

M odify Policy

Changes the policy that governs alerts set on this resource. This option requires the Assure
license.

Edit/Clear/Set Annotations

Allows you to assign a note to this resource so that you can later group or filter the
resources by the annotation. For example, you might want to group or filter resource by a
specific note or tier. You can also change annotations or remove them.

Related tasks

Allocating capacity to a new hoston page 43

Related references

Volume Summary tab on page 57

Volume Usage of Storage Pool view

To examine additional information for each volume in the Storage Pool Utilization Violations view,
open the Volume Usage of Storage Pool view.

Navigation

From the Open menu, select Assurance > Storage Pool Utilization Violations. At the bottom of the
view, click the Volume Usage of Storage Pooal icon.



108 | OnCommand Insight Performance Guide

Column descriptions

blank
Column that organizes the data according to the selected grouping format. Applicable with
any presentation order other than No Grouping.

Volume
Name of the volume.

Label
Full volume name within the storage array.
Type
The vendor-specific type of volume (for example, SFS or B.V.).
icon (array virtualization type)
Indicates type of virtualization. A "V icon showing on a volume indicates that the device
is a virtualized volume, and a "B" icon showing on a volume indicates that the device is a
backend volume.
Hosts
Hosts using the volume.
Application
Applications associated with this volume.
Application Priority
Importance of this application as defined when establishing the business entities.
Tenant, Line of Business, Business Unit, Project
Columns listing the business entity components associated with the applications.

Volume IOPS
Measures the total number of 1/O service requests on the volume during the time period of
the utilization violation (measured in 1/O per sec).

Volume Throughput
Rate at which data was transferred to/from the volume in response to 1/O service requests
during the time period of the utilization violation (measured in MB per sec).

Volume Response Time

The time it takes from the moment a request for information arrives at the storage device
to the time when the storage devices begin to send the information back in response. This
is the actual latency of the device, based on live samplings whenever possible.
OnCommand Insight measures response times from within the storage array. The value is
measured in milliseconds.

Volume Top Response Time

The maximum time it takes to send the information back.

Options
The following options are available from the right-click menu:

Analyze

Allows you to identify potential problems by isolating the location of contention and the
source of delays and by comparing performance data for different time periods to note
changes. The Volume Summary tab provides information that might be needed for
troubleshooting.

Analyze Storage Pools
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Allows you to select a specific storage pool and assess its status related to the thin
provisioning policies. You can use this dialog box, instead of the Violations Browser, to
see the current thin provisioning violations and how close the storage pool is to reaching
the policy limits.
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